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Overview

Overview
CAD-CAM systems are probably the most significant development in the field of new technology 
related to engineering, design and drafting in all technical spheres. These systems find application in 
all branches of modern design – from machine engineering and microelectronics to architecture and 
construction building and others. In current publication the author describes in detail via review, analysis 
and processing case study data the state of art in the selection, application and implementation of such 
systems.

The past decade has additionally witnessed the emergence of new manufacturing technologies that build 
parts on a layer-by-layer basis. Using these technologies, manufacturing time for parts of virtually any 
complexity is measured in hours instead of days, weeks, or months. In other words, it is rapid. A host 
of related technologies that are used to fabricate physical objects directly from Computer-Aided Design 
data sources are reviewed in the last chapter. These methods are generally similar to each other in that 
they add and bond materials in layerwise-fashion to form objects.

Download free eBooks at bookboon.com



CAD-CAM & Rapid Prototyping  
Application Evaluation

8 

Computer Programs In Manufacturing

1  Computer Programs In 
Manufacturing

1.1 Parametric Technologies

Pro/ENGINEER® is the best CAD/CAM/CAE system for the last 19 years in a worldwide scale. Parametric 
Technologies have achieved these results for less than 23 years. There is one single reason for this incredible 
break-through – the company offers revolutionary novel characteristics for the time. The parametric and 
associative nature of the application along with design operations, which in their character are close to 
the processes, involved in machine building turn the Pro/ENGINEER into a world leader [1].

 Fig. 1.1.

Dr Samuel P.Gaisberg found the company in 1985. He used to work as a chief engineer-programmer 
in the competitive companies Computervision and Applicon. He left Computervision in 1984 after his 
project was rejected. When Parametric Technology Corporation was found in 1985 he succeeded in 
finding a field for implementing his ideas one of which was the parametric model of designed parts and 
assemblies, which allowed for a revolutionary change in the approach to automated mechanical design.

The Pro-ENGINEER® leads the chart in this sphere with annual sales revenue of $600.1 million, which 
is around a 19% share of total sales of CAD/CAM/CAE systems and an annual growth of 52%. Around 
3350 people are employed in the company.
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The system has been constantly enlarged and new modules and functions added to it through the years. 
In 2002, a new revision of Pro/ENGINEER called Wildfire was released that dramatically changed the 
software’s graphical user interface. The version Wildfire 4.0 was offered in the market in 2008, which 
included over 75 modules and the Pro/ENGINEER® Wildfire 5.0 version was being offered in 2009. 
Attention is drawn mainly on the interface of the system, operation with multi-component products, 
data interchange with other CAD/CAM systems and team operation in Internet environment. The new 
model Behavioral Modeler allows for the creation of geometrical models maintaining certain behaviour 
when varying its dimensions.

The basic module Pro/Foundation provides Windows interface and automatic dimensioning of 2D 
sketches. The Pro/ENGINEER® Wildfire 5.0 comprises a large class modeler Pro/DESKTOP, which 
produces and consumes models created by other modules in the family. This provides automation of all 
industrial design activities involved, detail geometry design, preparations for manufacture, analysis using 
the method of finite elements and last but not least, overall control of complicated projects for products 
comprising over 10 000 components and assemblies. All modules operate on a general 3D model of the 
product all dimensions of the product being parametric.

Pro ENGINEER® provides the unique capability of competitive design achievable through simultaneous 
operation in all product development and production preparation stages. All revisions made in each 
design stage are automatically introduced in the other stages. This allows for the detail design to begin 
before the operation for industrial design has completed. Eventual corrections in the latter would be 
also introduced into the finished NC programs and drawings without any additional design engineer 
interference. This operation technique allows the users of Pre/ENGINEER® to be always a foot ahead of 
competitors as they design faster, make their revisions in the progress of work at each stage without any 
difficulties, produce less prototypes and their products have an appearance of maximum optimization, 
which saves materials and improves reliability [1].

 Fig. 1.2.
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There are over 130000 installed Pro/ENGINEER® workstations in over 20,000 companies worldwide 
by today’s day. There are hundreds of workstations linked in networks in many of them. Some of 
the largest users of the system are Volvo, BMW, Ferrari SpA, Volkswagen, Motorola, Polaroid, Texas 
Instruments, Canon, NEC, Silicon Graphics, SUN, PC with Windows. The minimum hardware required 
is Pentium 75, 64MB RAM, 500 MB available hard disc space, S3 compatible video controller. For 
professional applications powerful machines with Z buffer and Open GL built-in the graphics card 
are preferred with a fast disc, at least 17” monitor and the more memory available the better with a 
maximum fast processor.

The impressive thing about Parametric Technologies is that a new version of Pro/ENGINEER ® is released 
every year and this usually includes 2–5 new modules and around 400–500 additions requested by 
customers and this is offered for all supported hardware platforms and operation systems [1].

1.1.1 Production Modules In Pro/ENGINEER

•	 Pro/CASTING provides means for fast creation of moulding equipment and its components 
allowing the design engineer of the moulds to easily determine the geometry of the casting, 
the cavities and cores of moulds, to manufacture the finished castings and improve design to 
facilitate production.

•	 Pro/MFG-MILL creates NC programs for milling and drilling operations on 2.5 to 5 axis 
machines [2].

•	 Pro/MFG-TURN creates NC programs for turning operations along 4 axes providing 
control for double-carriage lathe centers [2].

•	 Pro/MFG WEDM creates NC programs for spark erosion along 2 to 4 axes [2].
•	 Pro/MOLDDESIGN facilitates the design of moulds and tools for processing plastics. It also 

performs analysis of the process of filling of the mould. Easily defines complicated parting 
surfaces [2].

1.2 Autodesk

1.2.1 Autocad Inventor Professional Suite

Autodesk’s manufacturing solutions are used in various manufacturing segments, including industrial 
machinery, electro-mechanical, tool and die, industrial equipment, automotive components, and 
consumer products. Products include AutoCAD Inventor Suite, AutoCAD Inventor Professional Suite, 
AutoCAD Mechanical, Autodesk Vault, Alias Product and Moldflow.
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 Fig. 1.3.

Available at the disposal of the design engineer are all capabilities listed above in the description of 
the AutoCAD Inventor Professional Suite but also included in this product is the 3D element library. 
Algorithms for engineering calculations of strength and deformations under static load using the finite 
element analysis (FEA) method allows the designer to analyse the construction in the design stage [2]. 
Powerful commands for dimensioning and editing of the drawing and model improve efficiency of 
AutoCAD Inventor users and reduce time by over 30%.

With a customer base of over 123 000 users AutoCAD Inventor is the product with the fastest growing 
market share in the industry. A significant part for this is played by the Autodesk partners in the MAI 
program who offer Inventor integrated applications for strength calculations based on MKE, kinematics 
and dynamic analysis of mechanisms. In addition CAM applications for 2.5D to 5-axes controls for 
metal processing machines, mould design, sheet metal components, tolerance analysis and dimensional 
build-up [2] are also offered.

 Fig. 1.4.

With the capabilities, production efficiency and ease of operation it provides the new version of AutoCAD 
Inventor Suite is a solution, which gives the users the freedom to create [2].

Download free eBooks at bookboon.com



CAD-CAM & Rapid Prototyping  
Application Evaluation

12 

Computer Programs In Manufacturing

1.3 Ansys

ANSYS is among the leaders in this type of systems. The program is based on the finite element theory 
and is developed in a package adopted in various sectors of industry. ANSYS could be modified and 
added to. For example, some specialized modules developed by the Spanish company Ingiciber SA and 
the Swedish company Anker-Zemer AB extend the capabilities of the standard package with means of 
providing solutions in the area of mechanics of building constructions and hydrodynamics in a limit-
element arrangement [2]. ANSYS, Inc. has acquired a number of companies since 2000, including ICEM 
CFD Engineering, CADOE, CFX, Century Dynamics, Harvard Thermal, Fluent, Inc. and Ansoft.

The pre-processor of ANSYS allows the user to create geometric models and import ready-made 
ones. When importing models the product performs retranslation of data in the ANSYS format and 
the geometric models could afterwards be modified. The system provides means for building surface 
and solid-body geometry and making changes in it. ANSYS solves problems from the area of thermo-
physics, hydrodynamics and the electromagnetic theory and makes parallel calculations for side loads 
and optimization procedures [3].

The program provides specialized final elements allowing not only shifting and rotation within the 
assemblies but also degree of freedom in temperature, stress, etc. The usage of these elements gives the 
customer possibilities to perform consistent analysis.
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The program for non-linear calculations LS-DYNA of the company LSTC is included in ANSYS as a 
completely integrated module providing specialized algorithms and support for a number of materials. 
The customer could use ANSYS and LS-DYNA to model the material processing techniques to analyse 
emergency situation (like, for example car crashes), final deformations, and interaction between a large 
numbers of bodies [3]. Solutions could be provided to problems involved in the behaviour of pre-
tensioned constructions (like, for example a body getting into a motor turbine and seismic analysis of 
equipment) and problems for investigating constructions subjected to strong deformations (for example, 
elastic springing of a thin stamped sheet) [4].

LS-DYNA of LSTC is a multi-functional program using the explicit finite element method and intended 
for analysis of dynamic deviations in three-dimensional non-elastic structures. Completely automated 
solution and the multiple final result checking functions allow successful application of the system in 
most complicated problems involving strikes and moulding [3]. The program provides over 25 algorithms 
for contact interaction and methods for solving problems in the area of:

non-linear dynamics, quasi-statics, acoustics, thermo-physics, etc. These analytical instruments provide 
modelling of a wide range of real problems [3];

estimates of striking resistance (for example, crash tests) for cars, planes, trains, etc. [3].

analysis of the dynamic strength of car parts, body, wheels, etc. when moving on an uneven surface [4]; 
occupant safety analysis.

The product provides means for analysis of metal forming, glass forming, and plastic moulding, rolling, 
pressing, stamping, etc., hydro-forming (including such involving large deformations), multi-stage 
processes, problems of streamlining, explosive loads of products, rivet and bolt connections, modeling 
of earthquakes [4].

ANSYS DesignSpace is a CAE product based on ANSYS and associated with leading CAD products 
and specifically intended for the design stage preceding the analysis stage. The designers and engineers 
involved in the analysis of a certain product are working together using the DesignSpace Expert 
automatically keeping a record of their work with DesignSpace Report [5]. The combination between 
the power of analysis of ANSYS and the CAD integration with DesignSpace creates a real environment 
for jointly development.

1.4 Ibm – Catia

CATIA is a highest-class system for automation of engineering labour. It is one of the undisputable 
leaders in the world of modern CAD/CAM/CAE systems.
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 Fig. 1.5.

CATIA was created by Dassault Systems and is being distributed by IBM and works on IBM graphic 
stations. It is one of the best-known and adopted worldwide systems taking a leading place in the 
CAD/CAM/CAE market for over 25 years. Meanwhile, it is one of the fastest developing systems. Its 
open and flexible architecture allows at least two new versions to be produced each year providing 
new functionalities and improvements [4]. The number of products in the system has grown up from 
58 to 108 for three years and most of them, as well as the system as a whole have undergone multiple 
renovations for this period.

In 1998, an entirely rewritten version of CATIA, CATIA V5 was released, with support for UNIX, 
Windows NT and Windows XP since 2001. In 2008, Dassault announced and released CATIA V6.[4] 
While the server can run on Microsoft Windows, Linux or AIX, client support for any operating system 
other than Microsoft Windows is dropped [4].

CATIA represents a unique integrated solution for creating and developing engineering products and 
their optimization in the conditions of team design. This high-tech solution is presently being used in 
over 9 thousand companies in the world. Many of the largest world manufacturers as well as companies 
with one or two employees draw competitive advantages from it and attain perfection of design [4].

It improves the entire product line of the system aiming at increasing customer competitiveness in the 
design, optimization, production and planning of resources [4]. Small and medium scale companies 
are offered a new and convenient to use module for assembling products based on the abstraction for 
graphic representation based on the hierarchy tree.

Customers, who consider the shape of the design of significant importance, like for example consumer 
goods or cars are offered a new product for efficient and high-quality data exchange between CATIA and 
ALIAS. This increases efficiency when designing shapes allowing easy agreement between the designer 
and engineer’s activities [4].

Download free eBooks at bookboon.com

http://en.wikipedia.org/wiki/Catia#cite_note-2#cite_note-2


CAD-CAM & Rapid Prototyping  
Application Evaluation

15 

Computer Programs In Manufacturing

 Fig. 1.6.

The product Generative Shape Modeling dramatically accelerates the process of detail design. The 
companies where the usage of highly efficient solid-body modelling is critical are able to take advantage 
of the serious improvements in efficiency compared to earlier CATIA. The drawing generation process has 
also been accelerated. These improvements are of primal importance for the design of motors, reducers 
and all types of machine mechanism where large models are usually involved [4].

The CATIA new version is a move forward to a new quality level of automation of technological operations. 
The Surface Machining Programmer product is a complete and easy to use selection of means for 
generating 3D programs for 3-axes milling machines. The Multi-Axis Machining Programmer product 
uses leading NCCS technologies and is addressed to the need of complicated machining in plane building 
techniques. As a whole, CATIA improves flexibility when selecting between two types of functionalities: 
fully interactive geometrically based ones and semi-automated process-oriented ones [5].
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This version significantly improves the analysis and optimization functions. The product Generative 
Part Optimization is intended to provide sensitive analysis and optimization of products with the aim 
of ensuring the best quality design in the fastest possible way and with minimum effort involved. The 
design engineer is offered intuitive analysis of shell structures, which adds to the existing functions for 
three-dimensional stress analysis. The two-dimensional arrangement of finite elements is significantly 
improved and enriched with methods allowing integration of streamlining tests in the design process.

Accelerating the design process for metal ships the CATIA Shipbuilding application has been completely 
revised to a site oriented product. It uses the unique intelligence of CATIA AEC architecture [5]. The 
product Product Manager Integration provides unique functions for integration between CAD/CAM/
CAE/PDM and company business management systems.

1.5 Datacad

Fig. 17 Fig. 18

DataCAD’s new version (13 – June 2010) includes [6] an all new AutoCAD compatible DXF/DWG 
translator. A digital Terrain Modeler (DTM), an estimator for Windows, an expanded 3D object libraries, 
improved display performance and WinHelp based online documentation [9]. The sofware is of primarily 
architectural and construction usage rather than manufacturing. Transferring files back and forth between 
DataCAD and AutoCAD is a breeze with DataCAD’s new translator. The DWG translator allows CAD 
users to benefit from the ease of use of drafting with DataCAD and easily exchange data with engineers 
and others who use AutoCAD. The new translator will convert custom linetypes in DataCAD to AutoCAD 
format, so your drawings will display in AutoCAD as they do in DataCAD [10].
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 Fig. 1.9.

Improved display list performance provides faster refresh time, object snapping, entity selection, and 
panning and zooming, improving the program’s performance by a factor of up to ten times the speed 
of DataCAD [11]. The Display List is engineered such that the closer you zoom into the drawing, the 
faster it performs. This is particularly important for drafting, where the user frequently zooms in on 
the drawing to perform edits and then changes views. Unlike an isolated feature, display list benefits all 
DataCAD users immediately and throughout the drawing process with increased program speed [12].

The Digital Terrain Modeler (DTM) allows you to quickly and easily model site plans from survey data 
or contour lines [13]. Making it easier to draft a realistic landscape, allowing for greater flexibility and 
creativity in producing realistic models and landscapes and addresses the site-related aspects of building 
design [13]. The DTM is, most importantly, easy to use. Simply create contours, points, or lines at varying 
Z-heights, and the terrain modeler will calculate a polygon surface through these points.

There are 1,500 new three-dimensional symbols, including three-dimensional cars and trucks; parking 
lot, roadway, and walkway lights; park benches; metal, plastic, and wood objects and furnishings; as well 
as everything for the modern cityscape [14]. In addition, DataCAD includes three-dimensional kitchen 
and bathroom cabinetry, plumbing fixtures and appliances give you more options for creating detailed 
3D models [14].

DataCAD Estimator for Windows, is also included on the DataCAD. Estimator offers instant totaling, 
“what if ” capabilities, an extensive help system, tutorials, markups and an unlimited bid items [15]. The 
estimator integrates with DataCAD and supports Quicken and Quickbooks formats.
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The WinHelp based online documentation is a user-friendly help system [15]. The dual-pane help 
window means you no longer need to go back and forth between navigating through the help system 
and displaying topics, and the Contents tab remains synchronized with the selected topic so you can 
better understand relationships between topics [16]. Printed documentation has also been improved; 
a completely revised and expanded reference manual is included with every upgrade. The manual is 
structured to reflect the way a CAD user works and includes a tutorial, whose exercises are synchronized 
with corresponding reference material [17].

The Productivity Pack includes new 2D and 3D icon toolbars that rapidly access DataCAD most frequently 
used functions. So that we can quickly and easily annotate the drawing at the correct scale with the new 
notation, dimension and text toolbars. Additional toolbars address 3D modeling, hatching and common 
2D drafting functions [17].
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2 Computer Programs In Design
2.1 Unigraphics Solutions

Solid Edge V1 was released in 1995, in October 1997 the Sheet Metal environment was introduced 
with V3.5. UGS switched from the ACIS modeling kernel to Parasolid in 1998 with V5. Solid Edge 
with Synchronous Technology was launched in 2008. Solid Edge with Synchronous Technology 2 was 
launched in 2009.

Fig. 2.1 

The new product version offers extended capabilities and new application oriented means for automated 
design of complicated machine parts made of plastic and aluminium, moulding and sheet metal products. 
The new capabilities in version 20 are accelerated by the STREAM technology of users interface offering 
the thousands of existing users the most efficient Windows based CAD system [1]. The new pipeline 
design module Xpress Route is leading the innovations in the new version.

 Fig 2.2
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This new module is used to design systems that transport fuel, oil, and air, cooling liquids, hydraulic 
fluids or electricity from one point in an assembled machine configuration to another. The pipes are 
being modelled in the context of the particular assembly and are completely associated with the parts 
and components they are connected to [1]. A new method of building thin cavities in restriction areas 
of the model, as well as new primitives to facilitate the designing of moulding tools were added in Solid 
Edge 20, as desired by the customers. The design engineers of plastic components could take advantage 
of the new function of “smoothing” angles and rounds as well as the new capabilities for previewing 
the results of the mould indexing operation. Several new functions were also added for designing sheet 
metal products where Solid Edge is a traditional leader [1].

For example, the users could now very quickly unfold metal sheets in seats intended to increase material 
strength characteristics.

Initially announced in 1996 Solid Edge continues to stand in its leading position in the CAD machine 
building industry adding up hundreds of improvements for the short time since the latest version 6 [2].

•	 Feature recogniser – This feature reads and automatically recognizes the primitives and 
operations in the description of each Parasolid file in the process of loading the file.

•	 Assemblies modelling – Improved creation of repeating primitive sequences, improved 
measurement means, conical and tangential contact conditions for assembly purposes.
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•	 Detail modelling – Copies the position of a detail relative to another available detail, new 
key curves – 3D spline, coordinate system, etc.

•	 Drawing – An automated feature generates a map of all openings and assigns dimensions 
and design surfaces in the drawing views.

•	 Translators – Open/Save As IGES or STEP and additional DXF extensions.
•	 Revision manager – A built-in PDM system operating independently from the basic CAD 

license.
•	 STREAM – A proprietary technology built into the Solid Edge, which speeds up user 

operation anticipating his intentions as the work progresses using interface logic and a 
decision management concept.

Solid Edge was written as 100% Windows application. It is 100% file level compatible with UNIGRAPHICS 
(another CAD/CAM/CAE + PDM software from Unigraphics Solutions) [2]. Solid Edge v.20 comprises 
the following functions and specialised modules:

•	 Solid Modelling – extended 3D solid-body modelling with Parasolid nucleus
•	 Plastics Plus – plastic and aluminium components and moulding
•	 Sheet Metal – sheet metal operation
•	 Assembly Modelling – assembly of machines, mechanisms and constructions
•	 Virtual Studio – photo realistic visualization and engineering animation
•	 Drafting – drawing and documentation
•	 Revisions manager – PDM system for versions control and parallel design in working 

groups
•	 Programming using a built-in Visual Basic
•	 Parametric libraries of standard elements
•	 Calculation and optimisation problems for machine designs
•	 Interfaces – MicroStation DGN, AutoCAD DWG/DXF, IGES, STEP, PARASOLID, UG Part, 

STL.
•	 Solid Edge ORIGIN 3D – a program for new and existing 2D AutoCAD users for transition 

towards 3D Solid modeling and drawing with 3D Solid modeling.

2.2 Autodesk

2.2.1 Autocad Mechanical /Power Pack

AutoCAD Mechanical is a 2D mechanical software design tool built on the AutoCAD platform. It allows 
drafting and designing mechanical pieces, and comes with a library of standard objects meant to increase 
productivity [3].
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 Fig. 2.3

AutoCAD® Mechanical design and drafting software is an AutoCAD® software for manufacturing, 
purpose-built to accelerate the mechanical design process. Part of the Autodesk solution for Digital 
Prototyping, it includes all the functionality of AutoCAD, one of the world’s leading 2D CAD design 
software, plus comprehensive libraries of standards-based parts and tools for automating common 
mechanical CAD tasks [3]. AutoCAD Mechanical design software helps save hours of design time. Added 
to this platform are strong machine design means providing faster and easier creation, editing, detailed 
view and management of machine projects and drawings [3].

An exceptionally convenient and intuitive user interface facilitates operation and practically leads to 
using specialized software functions. Some of the most useful and attractive capabilities are:

AutoCAD Mechanical with Power commands – a single command provides editing and copying, 
modifying detail and openings specifications and execution of commands for making other items.

•	 An automated layer control positions items in suitable layers
•	 Automated output and alignment of items in drawings of assembled units and generation of 

specifications
•	 Dimensioning, tolerances, roughness symbols, shape and size deviations according to a user 

selected design
•	 Management of two-dimensional assemblies
•	 AutoDetailing creates detail drawings based on the assembly drawing
•	 Extended Xref Manager and Block Editor

AutoCAD Mechanical Power Pack library containing over 500,000 standard machine elements, standard 
technological elements, over 20,000 standard openings, coupling elements, shafts generator, engineering 
shaft calculations, bearings, selection of materials, etc. [3].
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2.2.2 Inventor Professional

This is the best-sold Windows based 3D CAD system. This is due to the fact that two-dimensional 
and three-dimensional design, analysis and preparation for manufacture are performed in a single 
surrounding, faster and cheaper compared to most other systems available [4].

 Fig. 2.4
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The new version offers a number of improvements and new capabilities: InPlace Reference Editing 
[4] provides in-place editing in the assembly file of specified details defined in external files. This, along 
with the Design Center (a multiple file design surrounding), which provides simultaneous opening of 
several files and using and exchanging data between them, facilitates product design activities for products 
comprising a large number of details and assemblies.

Inventor Professional operates using a nucleus for Solid Modeling ACIS 5.0. The new version offers 
higher flexibility and stability when building the geometry with “blend”, “termination”, “loft”, “shell” and 
“surfacing”. The capability to define 2D splines in the side views gives the user freedom in outlining the 
sections, which along with the included generalized 3D sweep route provides unlimited flexibility in 
defining solid models [4].

The strong surface modeling functions involved are mainly directed at users from the tooling production 
sphere. It is possible to tack together and merge a large number of surfaces and the result of this merger 
could be a solid body or a new type of surface [4].

The new dynamic profile evaluation facilitates profile editing by means of real time grips and gives the 
user visual idea of the alterations.

There are also a great number of improvements in drawing and these include the algorithm for 
calculating hidden lines, multiple drawing sheets, cutting and insertion between separate sheets, and 
twisted cross-sectioning [4].

Mechanical Desktop also offers a wide choice of means to develop specialized application programs – 
ObjectARX, C++, VisualLISP, VBA, ActiveX.

 Fig. 2.5
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2.3 Cadtek Systems

2.3.1 Cocreate ME10

ME10 is the professional 2D design, drafting and documentation software tailored to the needs of 
mechanical and electro-mechanical engineers. As a team-based design solution, ME10 contains numerous 
technologies specially developed for workgroup cocreation such as powerful assembly design, revision 
checking, associative data structures and a superior integration into the workflow and data management 
software WorkManager. Furthermore, ME10’s [6]. Advisor Technologies make the difference between 
drafting and professional design. The Design Advisor and Dimension Advisor provide intelligent system 
consultancy during geometry creation and modification as well as automatic dimensioning.

Workgroup Co-creation in the Engineering Environment

Powerful Assembly Design – ME10 features a “parts concept” that simplifies the design and modification 
of assemblies through a hierarchical parts structure. With “shared parts,” several instances of a part may 
occur on the same drawing [6]. It’s also possible to define multiple drawing scales to handle assemblies 
with exceptionally large and small parts. A parts structure editor helps maintain control even in the 
most complex assembly structures. All design activities are simplified, such as defining sub-assemblies, 
creating instances, re-naming and changing ownership [5].

File Browser with Preview Window – When engineering teams work together on large assemblies, the 
importance of finding the correct parts quickly increases. Project leaders, in particular, will appreciate 
the capability of ME10 to preview parts before loading them. The preview window of the File Browser 
simplifies the process of merging parts to form large assemblies [6]. The File Browser also shows the 
file history of previously loaded parts, and makes it easy to access them by simply double-clicking on 
the file history list.

Revision Checker – ME10 provides a Revision Checker, which helps synchronise engineering work. 
The Revision Checker automatically highlights design changes, and notes differences between design 
revisions. Revision checking is also supported by WorkManager so that drawings which matched a 
database query can be transferred to ME10 to show differences [6].
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 Fig. 2.6

Design Modifications – With ME10, engineers have powerful modification commands that allow them 
to copy, rotate, mirror, scale and stretch all elements. Advanced trim and extend capabilities provide a 
quick, effective means to refine drawings and close contours [5]. Dimension-driven modifications allow 
quick design changes by simply changing the driving dimensions. To make design modifications an easy 
task ME10 provides advanced component selection commands that give engineers various ways to select 
drawing elements, like with a polygon area, Boolean operators or with element attributes [7].

Full Associativity – ME10 features a concept called “Intelligent Data Structures,” which form a foundation 
for providing full associativity by ME10.
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Complete Data Management Capabilities – WorkManager, the data management module deeply 
integrated into ME10, allows users to manage 2D drawings and ME10 parts [7].

 Fig. 2.7

Parts Library – Fully integrated with ME10, the Parts Library offers the best and most convenient method 
for efficient standard parts processing. The use of standard parts in the CAD environment contributes 
to shorter cycle times from design to production, reductions in part variety and part diversity, greater 
planning stability and more transparency in commercial applications [7].

Engineering Symbols – Engineering Symbols is the powerful tool integrated into ME10 for the easy 
creation of ISO and DIN tolerance and welding and surface symbols within mechanical drawings. The 
Engineering Symbols product allows users to design drawing symbols according to ISO symbols.

Design Advisor

Copilot – ME10’s Copilot capability offers intelligent, context-sensitive guidance to aid engineers during 
the creation of geometry. Key information is displayed on-line to help reduce errors and increase 
productivity [8]. Displayed information includes: geometry relationships such as parallels and tangents; 
important geometry elements such as centre points and vertices; and geometry proportions that are 
being created such as radius or diameter.

 Fig. 2.8
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Construction Lines – Construction lines are widely used on drawing boards, and are well known to 
designers. ME10 leverages this knowledge by providing a comprehensive set of construction commands 
that emulate a pencil sketch [9]. Construction lines can be composed of any type of linear or circular 
elements. The creation of complex shapes can be simplified by overdrawing construction lines.

Design Intent Capture – During geometry creation, ME10 generates design rules automatically and, 
as a result, captures the design intent. This way, sketches evolve into detailed drawings, which can be 
modified and refined simply by altering dimensions [10].

Dimension Advisor – More Built-in Intelligence

Automatic dimensioning – Groups of dimensions can automatically be created and placed with one 
keystroke. ME10 recognises potential interference’s of dimensions with other objects and automatically 
creates appropriate islands in the dimension pattern.

Pre-configured dimension styles – ME10 provides pre-set dimension styles for compliance with 
international drafting standards (ISO, DIN, JIS, ANSI).

Dimension style database – Beyond pre-set standard dimension styles, ME10 makes it easy to define 
and store user-specific dimension styles that are in compliance with company specifications. A dimension 
preview window assists during style definition and symbols can conveniently be defined with a font/
symbol editor [11].

Feature-based dimensioning – Frequently used geometric features, e.g. screw, can be stored together 
with dimension patterns. Once stored, ME10 recognises topological matches of design geometry with 
stored features. Dimension patterns can then be applied with one mouse pick [11].

Advanced Design Technologies

Parametrics – Parametric design capabilities provide a powerful, interactive way to adapt existing 
drawings and create families of parts. With these capabilities, it’s possible to accomplish the most complex 
design modifications by simply changing the driving dimensions. ME10 allows users to parameterise 
drawings and specify design rules whenever it makes the most sense in the design process. Users can 
parameterise all or any part of a design, while ME10 handles under and over constraint designs [12].

Customisation through Macro Language – ME10 features a comprehensive BASIC-oriented macro 
language which provides a high degree of customisation and ease-of-use. This language also allows 
structured programming, with on-line editing and debugging aids to meet highly specific and often 
complex needs [12]. The power of the macro language can be seen in ME10’s user interface which is 
based on this macro language. It is very easy to implement user preferences that allow a look and feel 
optimised to the needs of every user.
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User Interface – ME10’s user interface not only distinguishes itself for being easy to use but also fast. 
A flat structure of menu layers (main- and sub-menus) features self-explanatory commands, prompts 
and on-line help. Menus can be easily picked and arranged on-screen. The menu buttons are easy to 
understand for engineers because the text contains typical terminology for mechanical engineers. This 
drastically reduces learning time [13].

Growth into Solid Modelling with SolidDesigner – The fact that ME10 and SolidDesigner share the 
same design concepts guarantees the co-existence of both 2D and 3D design. Take for example the 
parts structure concept. Every engineer used to working with large assemblies in ME10, and using the 
corresponding parts editor, can apply the same ideas when working with SolidDesigner. Additionally, 
SolidDesigner’s integrated module – called SolidDesigner Annotation – guarantees an easy to use and 
fully associative drawing generation which easily integrates into an existing ME10 design environment 
as both systems support the same drawing format (native MI) [13].
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2.4 Solidworks

2.4.1 Solidworks 2010

SolidWorks is a 3D mechanical CAD (computer-aided design) program that runs on Microsoft Windows 
and was developed by Dassault Systèmes SolidWorks Corp., a subsidiary of Dassault Systèmes, S.A. 
(Vélizy, France) [8]. This product reflects the latest achievements in the world of engineering design, 
exclusively easy to understand and use and available for every machine-building company. These are the 
first and major characteristics of SolidWorks 2010 – SP4.0. The latest version of the product is the latest 
achievement in succession, which affirms it as a standard among the three-dimensional design systems 
operating under Windows [14].

A tool for reflecting engineering ideas

SolidWorks 2010 accelerates the process of reflecting and conveying engineering ideas. It allows alterations 
of dimensions, relations and geometry of engineering components to be made at any time and allows 
the user to return and rearrange the history of their creation. All data are 100% editable. All connections 
between details, assembled units and drawings are constantly current [14].

SolidWorks 2010 allows fast and efficient operation adequately using all typical means of Windows 
menus like indicating, selecting, copying, holding and shifting objects. It is easy to organize and develop 
complicated projects using the so-called FeatureManager, which reflects the history of creation of 
engineering components. The work of the user has been additionally facilitated by Internet access 
provided by the so-called FeaturePalette, a constantly updated library of standard details and engineering 
components [15]. The product Solidworks Viewer allows a wide group of engineers and managers to 
view and supervise the development of the projects.

The latest version of SolidWorks has means built-in to ease transitions between two-dimensional and 
three-dimensional design, which include an AutoCAD command emulator. This emulator allows 
AutoCAD users to apply their acquired habits and skills to create drafts and drawings in SolidWorks [15].

Efficiency and ease in creating drawings

Solidworks 2010 offers means for efficient generation of technical documentation at minimum effort. 
Drawings are generated automatically from three-dimensional models and include all drafting elements – 
views, cross-sections, dimensions and notes. The drawings generated are completely associated with 
respective three-dimensional models-details and assembled units, so each change in the drawing is 
reflected in the model and vice versa. Adopted are the standards ISO, ANSI, DIN, JIS, BS and GOST [15].
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The latest version provides simpler detail means especially when making detail views and cross-sections. 
Various layers could be maintained. The conditions for more complete implementation of company 
standards and proprietary symbols, texts and formatting frames have greatly been improved [16]. Some 
capabilities have been added to provide copying views from different sheets, making tabulated drawings 
as well as adjustment of various gauges for material specifications.

Impressive capabilities for designing assembled units

 Fig. 2.9

SolidWorks 2010 allows building of assembled units by means of direct addressing to details already 
created and creating new details in an existing assembly unit based on the built up geometry. SolidWorks 
2010 offers impressive efficiency and convenience when using both methods also known as bottom-to-
top and top-to-bottom design [16]. Interconnections – alignment, concentricity, parallelism, distance, 
tangential have been adopted between the elements of an assembly unit This makes the assembly unit a 
kinematical mechanism, which can be moved to test the kinematical links and interrelation of separate 
mechanism components. SolidWorks 2010 has a built-in Collision Detection, which establishes any 
available inter-collision between separate parts of the mechanism in real time [16]. When this is activated 
and the user actuates the mechanism the colliding elements are illuminated in red light and when the 
respective operation is activated the movement is immediately interrupted.

Independent components in the assembly unit in SolidWorks 2010 could be reorganized, grouped 
together and rearranged in an exceptionally flexible manner using the well-known FeatureManager. The 
design of assembly units could be accelerated by means of the so-called SmartMates – an intelligent means 
or pre-determining the possibilities for linking geometrical elements when moving them [17]. Processing 
and visualization of large assembly units is considerably facilitated by the possibility for partial loading 
of participating details and sub-units into the so-called Lightweight mode. An especially important role 
has been given to the freedom of the user to operate with various alternatives called configurations both 
for the entire assembly unit and for all its separate sub-units [17].
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Improved detail design means

SolidWorks 2010 provides the user with more than what could be expected for a three-dimensional 
design system. He can easily create with it three-dimensional objects without using the Extrude and 
Revolve operations, build cavities, make rounds and create bodies and surfaces using the Loft and Sweep 
operations. A significant improvement is the so-called dynamic editing of geometric objects where a 
certain body reacts to the alterations in real time from the very process of editing side views over which 
this body is to be built [18]. The so-called 3D Sketcher appears in the latest version, which allows users 
to design three-dimensional curves making simultaneous sketches in several planes. The visualization 
of objects has also been improved by introducing additional means to control illuminating lights. The 
means generating uneven surfaces typically used for press and injection moulding equipment have also 
been improved [18].
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 Fig. 2.10
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3  Cadcam System Selection, 
Evaluation & Management

In this chapter a report for a CADCAM selection, evaluation and management (implementation) of the 
system is described. This is a “case study” method of research with focus for an in-depth investigation 
on the use of CADCAM systems. Engineers act as consultants in a small company involved in the 
introducing CAD-CAM systems.

What does it mean to introduce a CAD-CAM system? It involves complex activities covering all stages; 
from identifying customer needs giving consideration to its individual capabilities, to the selection stage 
and instalment of the optimum software meeting customer needs [1].

3.1 Pros & Cons Of Introducing A Cadcam System

The current task has been to consult the introduction of a suitable CADCAM system in Pumpco – a 
manufacturer of pumping equipment for various industrial applications. The main objective of the 
company is to implement the CADCAM system to optimise the design process and provide integration 
with production. Following discussions with the managerial board and the undertaken study, we were 
able to identify the factors influencing the selection of a suitable CADCAM system for Pumpco:

 Fig. 3.1

•	 Pumps are being designed within the company itself. A number of the components are 
company manufactured as well.

•	 Most pumps are specifically designed and manufactured to suit particular customer needs.
•	 Each individual pump is sold with its own assembly drawing and parts list.
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 Fig. 3.2

As specialists, we are aware of the benefits of implementing CADCAM, nonetheless the hardest part was 
to convince the Pumpco managerial board, in order to achieve the optimum result. Hence, a presentation 
was made where we included all arguments in favour of introducing CADCAM. Also, and decided to 
explain possible drawbacks which could cause difficulties.

Firstly, we emphasised the benefits associated with the 2D drawing process:

•	 The average statistics indicates that a draftsman will produce drawings three times faster 
using CAD systems compared to when using a conventional drawing board [1];

 Fig. 3.3

•	 High drawing accuracy. Every point in a CAD drawing has its precise position;
•	 Perfectly made drawings. CAD’s graphics system and computer printing ensure excellent 

lines and text;
•	 Assembling of drawings. Every completed drawing or part of a drawing can be computer 

memorised for further use.
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We also emphasised the benefits offered by CAD systems for 3D modelling:

•	 Fast calculations and analysis ensured by modern computer equipment and software 
packages;

•	 Superior form of design. Powerful computer modelling techniques, such as finite element 
analysis, have freed the designer from the shackles of restrictive conventional formulae 
and allowed more inventive shapes to be developed. These shapes may be quickly modified 
and optimised for cost savings to an extent which would have previously been too time-
consuming.

•	 Less development required. CAD simulation and analysis techniques can drastically cut the 
time and money spent on prototype testing and development – often the costliest stage in 
the design process.

•	 Integration of design with other disciplines. The vastly superior communications available 
under an integrated computer network enables CAD to work far more closely with other 
engineering departments than was possible under the old type of design organisation.

•	 Access to CAD technology means that the marketing personnel can be included in the 
concurrent engineering process. When designs are finalised and prototypes developed, 
marketing can use these to generate illustrations for packaging [1].
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Another advantage to be explained was the CAD-CAM interrelation. It needed some clarification: 
CADCAM is an integration of CAD and CAM techniques into one complete process. This means, for 
example, that a component can be drawn on a VDU screen and the graphics data then transferred via 
coded electrical signals along a cable link to a manufacturing system, where the component would be 
automatically produced on a CNC machine.

Fig. 3.4.

We emphasised the benefit of expecting results from using CAM in the company considering the fact 
that the available CNC’s could be used for the time being:

•	 Higher production rates with lower workforces;
•	 Less likelihood of human error and the consequences of human unreliability;
•	 Greater versatility of manufactured form;
•	 Cost savings due to increased manufacturing efficiency (e.g. less material wastage) and 

increased efficiency of storage and assembly [2];
•	 Repeatability of production processes via storage of data;
•	 Superior product.

Finally, we pointed out the positive financial aspect of introducing the CADCAM system: Superior 
Product, Cheaper Product, Shorter Delivery Times, Quicker Sales Quotations, Faster Drawing and 
Production Rates, Lower Production Costs, Lower Labour Costs, and Lower Development Costs.

We also had to distinguish factors that were likely to cause certain difficulties:

•	 High Purchase Cost of the System.
•	 Defective information integration policy.
•	 Effect on manufacturing flexibility. What would happen with the custom-designed products?
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•	 Redundancy. This is obviously the principal fear of any employee involved with the change 
to new technologies.

•	 The amount of time required for implementation. Problems may arise because of different 
level of technology integration, personnel may be unfamiliar with utilisation.

•	 Effect on labour relations. Passing of Old Skills. Some employees may feel resentment that 
particular skills in which they may have excelled, such as the ability to produce hand-
printing, or turn fine surfaces are irrelevant to CADCAM [2].

Introducing a CADCAM system is a complex activity that should involve the support of all company 
managers and specialists. Therefore, we proceeded with selecting the suitable systems.

3.2 Method Of Proceeding

The method for proceeding has been based on the results analysis from the study and the following 
activities [2] were carried out based on: 1) defining production interests, 2) formulating specific 
requirements for CADCAM suppliers, 3) preliminary comparative market analysis, 4) testing eventual 
suppliers and 5) follow-up synthesis of possible solutions. To accomplish this line of action, we have 
had extensive discussions with managers, design engineers and production and marketing specialists 
in Pumpco. We have identified two basic stages of study and fixed some of their areas of coincidence:

1. Company study [3], aimed at identifying both company needs and company capabilities. Having 
compared these two, the optimum requirements for the supplied software can be identified. The 
study concentrated on several basic aspects: the technical and production aspect, the time aspect, 
the staff and qualifications aspect and the financial and economic aspect.

2. Market study [4], for a software specialised in the CADCAM field.

3.2.1 Pumpco’s Production Interests

The main purpose of introducing the CADCAM system is to optimise the design process and integrate 
it with the manufacturing processes [3]. One pre-condition for the successful application of this system 
is to identify the activities to be involved in these processes and the expected improvements. Pumpco is 
a manufacturer of a wide range of pumping equipment used in various industrial applications. Pumps 
comprise the following components:

•	 Body parts (body, flanges, turbines)
•	 Company manufactured component parts using design drawings made in the design 

engineering department of the company
•	 Standard company manufactured products
•	 Standard bought-out components
•	 Electrical elements

Download free eBooks at bookboon.com



CAD-CAM & Rapid Prototyping  
Application Evaluation

41 

Cadcam System Selection, Evaluation & Management

Pumps are usually sold out with company-made assembly drawings and specification sheets. My 
summarised conclusions for the processes accompanying the production of basic components are as 
follows:

Component parts: These are manufactured to design drawings prepared in the company’s own design 
department. Some of these parts are sub-contracted with other manufacturing companies. It is also 
possible to use CNC machines in the company or other manufacturers to make these parts. Only current 
drawings are used for the manufacturing process [6]. A major objective to the design of these parts is 
to achieve unification of design characteristics.

Standard parts and components: These are made-out or bought-in parts. Recent standardisation 
documentation should be available in the company to use as reference when preparing assembly drawings 
and part drawings. It would be preferable to use a CAD system with a large library set of such standard 
component parts. This should regularly be updated using the Internet [7].

Electrical parts: Used to provide power supply for pump motors.

Assembly drawings: These are prepared for each individual pump and are usually accompanied by parts 
list. Possibility should be provided here for final product cost calculations.
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3.2.2 Formulation Of Specific Cadcam Requirements

We were able to formulate specific requirements for the CADCAM system, within diverse areas:

•	 Technical and manufacturing requirements:
 - Integrated calculations of machine elements and standard element database.
 - Integration of the design department and the economic department of the company;
 - 3D design capability and automatic production of 2D drawings based on the 3D 

model, assembling and linkage between all listed above in both directions;
 - Automated exploded views; automated generation of specification lists;
 - Calculations and dimensioning of turbines and turbine components, including 

for pump design and analysis purposes, calculation of fluid dynamics directly in a 
CADCAM modelling environment;

 - Direct exchange of data and drawings via the Internet;
 - Availability of libraries of standard elements; compliance with various international 

standards – ISO, DIN, ANSI etc.;
 - Possibilities for direct CNC machine operation using the appropriate programming 

automatically based on the produced 3D model.
 - Guarantee period and follow-up service and maintenance
 - The system must provide for further upgrading and adding new modules.

•	 Time aspect requirements:
 - Minimum training time and minimum time to achieve maximum efficiency of use of 

the CADCAM system.
 - Time of software going out of date and depreciation time of the hardware 

configuration.
 - Minimum time for creating engineering drawings based on the 3D model;
 - Staff and qualification requirements:
 - Easy to use software;
 - Initial training provided by the supplier of the CADCAM system and follow-up 

training in the course of actual operation in production conditions;
 - Initial training must also include a beginners’ computer course to cover a wider range 

of specialists.
 - Financial requirements:
 - Low software cost
 - Comparable prices of the software product and the hardware configuration (which 

includes computers and peripheral equipment)
 - Possibility to pay in several regular instalments.
 - Minimum installation cost.
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3.2.3 Cadcam Market Study

Based on the identified requirements, a preliminary comparative analysis of the capabilities and 
characteristics of the specialised software has been made. Two of the CAD/CAM systems met Pumpco’s 
needs to a large extent:

•	 Solid edge v.20
•	 Autocad inventor professional

Based on personal experience, we have presented a concise analysis of each product in the company’s 
managerial directors:

3.2.3.1 Autocad Inventor Professional

This is a powerful and flexible professional system for 3D modelling based on Auto CAD 2008 platform. 
Inventor professional is a suitable solution for parametric and surface modelling of solids allowing flexible 
and intuitive design work in both 2D and 3D environment, also offering possibilities for strength analysis 
and engineering calculations [8].

 Fig. 3.5

The Power Pack module is completely integrated into the AutoCAD Inventor Professional Suite to ensure 
even higher productivity offering libraries containing over 1.2 million standard 2D and 3D components, 
holes, bearings, springs, etc. along with intelligent arrangement and positioning of components and some 
engineering calculations, i.e. everything that would facilitate engineering design activities in Pumpco.

The software features improved possibilities for solid modelling. Efficiency is greatly increased and 
designer’s ideas are assisted by intelligent tools and commands [9]. AutoCAD Inventor offers fast and 
convenient means of creating various geometric shapes. Many of these components are subject to 
subsequent design work by pump production.
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Several improvements in AutoCAD Inventor can result in an immediate increase in the efficiency of 
producing various models and drawings and this is definitely going to raise the interest of Pumpco 
specialists:

•	 Flexible creation of assembled models.
•	 Improved production of engineering drawings.

Integrating AutoCAD Inventor’s complete functionality into latest Internet technology will offer Pumpco 
customers better opportunities of using created designs and convenient information exchange with 
colleagues. The benefits of the new functions are expressed in several basic directions:

•	 Online exchange of data and information;
•	 Updating Autodesk based software;
•	 Team work using the Real-time design feature: it is possible for other people to watch design 

work in real time conditions [10].

Download free eBooks at bookboon.com

Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

How to retain your  
top staff

FIND OUT NOW FOR FREE
Get your free trial

Because happy staff get more done

What your staff really want?

The top issues troubling them?

How to make staff assessments 
work for you & them, painlessly?

DO YOU WANT TO KNOW:

http://s.bookboon.com/performancereviewpro-bookboonlp


CAD-CAM & Rapid Prototyping  
Application Evaluation

45 

Cadcam System Selection, Evaluation & Management

3.2.3.2 SOLID EDGE V.20 – UNIGRAPHICS SOLUTIONS -SIEMENS

Solid Edge finds wide application in a number of industrial fields and engineering activities [11]. Some 
typical applications include:

•	 Design of machine components, spare parts for machines and non-conventional equipment, 
design of complicated machines and mechanisms involving a large number of components, 
with integrated 2D/3D solid modelling, modelling of assemblies with kinematical analysis, 
sheet material, documentation including specification sheets and cost analysis of products;

•	 Hydraulic and pneumatic equipment, hydraulic motors, cylinders and drive units, 
compressors, refrigeration units and machines involving hydro-, pneumo-, and electrical 
installations and connections;

 Fig. 3.6

Included in the package are the following options, which will definitely be of interest to the specialist 
in Pumpco:

•	 A user interface predicts designers intentions;
•	 Intelligent sensors track critical dimensions and ratios in assemblies. Rapid modelling of 

large multiple component assemblies;
•	 Integrated system for design documentation and data control;
•	 Integration of design departments and economic departments within the company;
•	 Integrated calculations of machine elements and a database of standard elements. Direct 

control of structures using engineering tables;
•	 Modelling of formatted pipes and pipework. Solutions to hydro-pneumo-driving mechanism 

tasks in the context of specific assemblies;
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Additionally, SolidEdge offers a wide range of fully integrated applications and 3D libraries of standard 
elements developed by other CAD software manufacturers. There are over 150 different additional 
software products, specialised applications and libraries. An example of such an optional product which 
could be helpful for Pumpco specialists is CETI software used for dimensioning turbines and turbo-
components, including for design purposes; analyses of pumps, compressors, pneumatic compressors, 
fans, turbines and expanders [12]. These two systems are among the best in CAD/CAM applications, 
having unquestionably their drawbacks also.

3.3 Procedure For The Final Selection

As consultants, we prepared and performed a benchmark test to identify the CAD/CAM system that 
we were going to offer to the management of the company and that would give me the confidence of 
achieving the desired result.

The requirements placed before the CAD/CAM systems have been considered as of dissimilar significance 
to the company [13]. There are some of them, which are a particular necessity, and the work quality is 
dependent on them (fixed requirements) and others, which support and facilitate activities and software 
usage. In order to analyse how various CAD/CAM systems meet these requirements we will adopt a 
specific score method of assessment – benchmark test (Table 3.1) [14]. Various requirements will be 
assessed to a maximum score number relevant to their overall significance. This will be accomplished by 
means of allocating up to 50 scores to highest priority requirements (those, which are most significant 
to the company), while requirements of lower significance to the company will be assessed to a lower 
maximum number of scores, 30, 20 and 10. Thus, after finally adding up the scores, the CAD/CAM that 
does not meet the basic company requirements will be rejected.

The classification of requirements according to their significance is based on considerations and priorities 
accumulated in the course of the analysis of preliminary study results.
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No Requirement
Max No. 
of points

SOLID 
EDGE  
v.20

AUTOCAD 
INVENTOR 

PROFESSIONAL

1 Significant time savings in design work 50 48 46

2 Simple-to-use 50 40 45

3 3D Modelling 50 47 45

4 2D CAD 50 40 50

5 Assembly 50 46 45

6 2D and 3D feedback connection 50 46 50

7 Price 50 40 45

8 System compatibility with the operation system selected by 
the company

50 50 50

9 Simplified conventional drafting via built-in intelligence 40 35 33

10 Available standard element libraries and databases 40 32 35

11 Capabilities to operate in networks 40 40 40

12 System service and maintenance offered 40 40 40

13 Automatic blending, trimming and filleting of intersecting 
surfaces

40 38 36

14 IGES interface for communicating with other CAD systems 40 36 38

15 Intuitive workflow 30 30 30

16 Supporting and automated conversion between 
international drawing standards

30 30 30

17 3D-CNC Programming from drawings, models or IGES data 30 26 27

18 Minimum hardware configuration 20 15 18

19 Realistic product visualisation with dynamic rotation of 
images

20 18 16

20 Electric design automation 20 20 20

21 Calculation of volume and area 20 20 20

22 Availability of self-tuition programme 10 10 10

23 Engineering analysis 10 10 10

24 Virtual elimination of laborious construction geometry 10 9 8

25 Design calculations and dimensioning of turbines and 
turbo-components, including for pump design and analyses 
purposes

10 8 6

26 Оn – line data and information exchange with colleagues 10 9 10

27 Possibilities to update software 10 10 10

Final score 870 793 813

Table 3.1
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The applied technique is based on the comparative analysis method. The final score resulting from adding 
up all scores in the vertical direction determines the capabilities of a CAD/CAM system to meet our 
particular requirements. The general conclusion from the above comparison between the two software 
packages is that SOLID EDGE v.20 has a number of advantages in modelling compared to AutoCAD 
Inventor Professional Suite, which is preferable for preparing AutoCAD based drawings and provides 
better chances for Internet communications. The CAD/CAM system to get the highest score is AutoCAD 
Inventor Professional Suite and this was our choice for Pumpco.

3.4 Master Implementation Plan

Given the difficulty of managing technological changes, the engineers had to come up with an operation 
implementation strategy, for the company to start utilising the system in an effective way [15]. Hence, 
an implementation plan for a successful system operation has been drawn to consider the following:

1. Allocating sufficient resources.
Purchasing of computers and accompanying peripheral devices. Network establishment. 
Commissioning and Installation of the CADCAM system by the supplier [15].
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2. Setting up workstations.
Setting up 5 workstations in Pumpco’s design department – two for R&D activities and 3 for 
preparing drawings for customers. One of the computers will be used as a server where the 
new electronic archival storage of the company will be located and the rest will be used for 
the workstations [16].

3. Training of the design office. Restructuring of jobs. Worker Displacement.
Beginners’ computer training will be provided for all employees and one engineer and three 
draftsmen will undergo specialised training to use AutoCAD Inventor Professional Suite. Forty 
percent of the hand drawings will be stored in the course of the specialised training exercise. 
Trained specialists will then train their associates;

An engineer will be responsible for the R&D unit (and the server) and the other will deal with customers. 
The two older draftsmen will stay in the office until their retirement is due. Other draftsmen could also 
stay to work for the company for the time being as the process of moving from hand-drafting to computer 
processing will have to be smooth and will take some time. All of them will be given opportunity to 
work on the computer stations observing a specific time schedule [17].

Five months later an analysis of the progress of draftsmen could be made to select those who will continue 
to work for the design department and the rest will have to be offered alternative jobs.

1. CADCAM control over planning of Productional capacity, materials needed, processes 
and CNC programming.
Preparation of the CNC machines. General equipment inspection; purchase of additional 
equipment. CAD part programming will be entered and edited directly to the CNC’s machine 
units to produce the first parts. Further practical training will be done on interrelation between 
CADCAM and the CNC’s to achieve a computer driven processing [18].

2. CADCAM control over production planning, order entry, production economics.
High flexibility of Production Planning: The new flexible technology will be used in the 
planning of production processes. Many product models will be produced to appeal to markets 
that demand product variety. Small batches of many product models will be produced and 
production processes will be economical to operate under these conditions [19].

Fast delivery of customer orders: With small batch sizes, operations that can be quickly changed 
to other products, and fast production rates, customer orders will be produced and shipped 
quickly utilising the order entry module [19].
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Changed Production economics: With the introduction of CADCAM technology, the majority 
of costs will be estimated. Fixed, variable and predominant costs will be transferred into the 
system’s DATA BASE module to be regularly checked up during the course of the first two 
months. Overhead costs in equipment, tooling, maintenance and billing will be accessible to 
the Company’s Purchasing, Design and Accounting offices [20].

Fig. 3.7

3.5 References

1. T. Hanada, B.P. Bandyopadhyay, T. Hoshi. Implementation of low-volume FMS for prismatic 
components. Journal of Manufacturing Systems, Volume 14, Issue 2, 1995, Pages 91–108.

2. Bartholomew O. Nnaji, Ashok K. Vishnu. A generalized shape descriptor from wire frame 
models on a CAD/CAM system. Journal of Manufacturing Systems, Volume 5, Issue 4, 1986, 
Pages 231–241.

3. Juan L. Aragón, Alexander V. Veidenbaum. Optimizing CAM-based instruction cache designs 
for low-power embedded systems. Journal of Systems Architecture, Volume 54, Issue 12, 
December 2008, Pages 1155–1163.

Download free eBooks at bookboon.com



CAD-CAM & Rapid Prototyping  
Application Evaluation

51 

Cadcam System Selection, Evaluation & Management

4. Lidia Fuentes, Mónica Pinto, Pablo Sánchez. Generating CAM aspect-oriented architectures 
using Model-Driven Development. Information and Software Technology, Volume 50, Issue 12, 
November 2008, Pages 1248–1265.

5. M. Jolgaf, A.M.S. Hamouda, S. Sulaiman, M.M. Hamdan. Development of a CAD/CAM system 
for the closed-die forging process. Journal of Materials Processing Technology, Volume 138, Issues 
1–3, 20 July 2003, Pages 436–442.

6. Jung-Fa Hsieh, Psang Dain Lin. Application of homogenous transformation matrix to 
measurement of cam profiles on coordinate measuring machines. International Journal of 
Machine Tools and Manufacture, Volume 47, Issue 10, August 2007, Pages 1593–1606.

7. O. Navarro, C.-J. Wu, J. Angeles. The size-minimization of planar cam mechanisms. Mechanism 
and Machine Theory, Volume 36, Issue 3, 1 March 2001, Pages 371–386.

8. J.X. Gao, B.M. Manson, P. Kyratsis. Implementation of concurrent engineering in the suppliers 
to the automotive industry. Journal of Materials Processing Technology, Volume 107, Issues 1–3, 
22 November 2000, Pages 201–208.

9. Roy M. Salzman. The evolution from CAD/CAM to CIM: possibilities, problems and strategies 
for the future. Computers & Graphics, Volume 9, Issue 4, 1985, Pages 435–439.

10. Paul S. Goodman, Terri L. Griffith. A process approach to the implementation of new 
technology. Journal of Engineering and Technology Management, Volume 8, Issues 3–4, 
December 1991, Pages 261–285.

Download free eBooks at bookboon.com

Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

EXPERIENCE THE POWER OF 
FULL ENGAGEMENT…

     RUN FASTER.
          RUN LONGER..
                RUN EASIER…

READ MORE & PRE-ORDER TODAY 
WWW.GAITEYE.COM

Challenge the way we run

1349906_A6_4+0.indd   1 22-08-2014   12:56:57

http://s.bookboon.com/Gaiteye


CAD-CAM & Rapid Prototyping  
Application Evaluation

52 

Cadcam System Selection, Evaluation & Management

11. Suk-Hwan Suh, Sung-Kee Noh, Yong-Jong Choi. A PC-based retrofitting toward CAD/CAM/
CNC integration. Computers & Industrial Engineering, Volume 28, Issue 1, January 1995, 
Pages 133–146.

12. Bjørn Moseng, Bjarte Haaøy Nes Integration of CAD/CAM as seen from the production 
planners’ point of view. Computers in Industry, Volume 5, Issue 4, December 1984, Pages 341–350.

13. Guido Gürtler, CAD Standard parts file  –  A DIN project in the standards committee on tabular 
layouts for article characteristics. Computer Standards & Interfaces, Volume 6, Issue 4, 1987, 
Pages 473–481.

14. Jakob Vlietstra, Integration aspects in CAD and CAM. Computers in Industry, Volume 5, Issue 4, 
December 1984, Pages 295–296.

15. D.A. Linkens, CAD for control systems  –  a review of PC software. Computer-Aided Design, 
Volume 20, Issue 9, November 1988, Pages 564–565.

16. Yoshihiro Ochiai, Tsuyoshi Sekiya, Generation of free-form surface in CAD for dies. Advances in 
Engineering Software, Volume 22, Issue 2, 1995, Pages 113–118.

17. Lex Lennings, CAD/CAM integration in practice: Two cases of computer aided toolmaking. 
Computers in Industry, Volume 18, Issue 2, 1992, Pages 127–134.

18. W. Sun, B. Starly, J. Nam, A. Darling, Bio-CAD modeling and its applications in computer-aided 
tissue engineering. Computer-Aided Design, Volume 37, Issue 11, 15 September 2005,  
Pages 1097–1114.

19. Žiga Turk, Object-oriented modelling and integrated CAD. Automation in Construction, 
Volume 1, Issue 4, March 1993, Pages 323–337.

20. Emad S. Abouel Nasr, Ali K. Kamrani, A new methodology for extracting manufacturing 
features from CAD system. Computers & Industrial Engineering, Volume 51, Issue 3, 
November 2006, Pages 389–415.

Download free eBooks at bookboon.com



CAD-CAM & Rapid Prototyping  
Application Evaluation

53 

Cam Application Evaluation: A Model Processing Case Study

4  Cam Application Evaluation: A 
Model Processing Case Study

The chapter presents the processing of a solid model part (mastsktfrg.prt) through the manufacturing 
module of ProEngineer and the same part exported as an igs file (mastskt.igs) through EZ-CAM, a 
stand alone CAM application. The following basic tasks have to be accomplished for the purposes of 
the present development:

•	 Developing a manufacturing process plan for a fully featured part suitable for CNC 
manufacture on a three axis machining centre.

•	 Produce a full set of machining sequences for the manufacture of a part.
•	 Use CADCAM software (both systems – Pro/engineer and EZ-MILL) to simulate the 

manufacturing of the part and to estimate the machining time.
•	 Comparing and contrasting two CAM software applications based on own experiences 

gained from using the software

The following software applications were adopted to carry out the specified task:

•	 Pro/ENGINEER Firewall
•	 EZ-CAM, module EZ-MILL

A solid model part was pre-defined using the available files: – mastsktfrg.prt (Pro/ENGINEER file 
format) and mastskt.igs (the same model part but exported in an igs format to allow it to be imported 
and processed in a EZ-MILL). The model part was build up as a solid part using the Part module of 
Pro/ENGINEER Firewall and using the igs file – mastskt.igs as a basis. The Tooling Catalogue (Sandvik 
Die & Mould Catalogue) [1] was used in the cutting tool definition part of the task where cutting tool 
characteristics and cutting conditions were defined.
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The following sequence was observed for the methodological proceedings involved in the 
accomplishment of the task:

•	 Technological analysis of the design solid model and preliminary definition of required NC 
Sequences in accordance with the analysis results;

•	 Definition of appropriate cutting tools and calculating cutting conditions;
•	 Using Pro/ENGINEER to simulate the manufacturing process of the part on the three axis 

machining centre;
•	 Using EZ-MILL to simulate the manufacturing process of the part on the three axis 

machining centre;
•	 Discussion relating to usability and available features of each software, including 

machinability data related to the manufacturing processes;
•	 Identifying and analysing innovative approaches to optimise the manufacturing Process plan 

(scheme).
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4.1 Technological Analysis Of The Model

The solid model in Fig. 4.1 represents a component part of the following overall size 
230mm×150mm×60mm. We assume the part is made of steel of Brinell hardness of HB = 170. It is 
made up of a bottom parallelepiped shape (1), a top protrusion (2), a cylindrical pocket of OD ∅90mm 
and 30mm deep (3), a rectangular pocket with edges chamfered to 5mm radii and 20mm deep (4), 
a set of 4 holes of ∅20mm OD (5), a set of 7 holes of ∅12mm OD (6), pockets shaped to read “JBa” 
positioned along the sides and 2mm deep (7).

 Fig. 4.1

Therefore, if we assume the workpiece to be a block of material with the size of 230mm×150mm×60mm, 
the following operational sequence will be required and sufficient to produce the design model piece:

•	 Milling the top protrusion (2 – Fig. 4.1). A cutter of ∅63mm OD can be used for the 
purpose, which will allow a single profile to be cut into various depths to remove the 
excessive material.

•	 Milling the cylindrical pocket (3 – Fig. 4.1). A smaller diameter, 25mm cutting tool is better 
used here due to high shear forces resulting from larger diameter cutters.

•	 Milling the rectangular pocket (4 – Fig. 4.1). Since its chamfer radii is 
R = 5mm, the cutting tool to be used shall be a smaller radius milling machine, for example 
R = 4mm (or ∅8mm).

•	 Drilling the set of 4 holes of ∅20mm OD (5 – Fig. 4.1).
•	 Drilling the set of 7 holes of ∅12mm OD (6 – Fig. 4.1).
•	 Milling the 2mm deep text pockets positioned alongside (7 – Fig. 4.1). The width of the 

groove in the narrow section of the letter “a” allows for using a cutter of a diameter of no 
more than 1.2mm. This operation shall be carried out using the same machine but with a 
different positioning of the part, the Z axis of the machine being perpendicular to plane of 
the “JBa” writing.
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4.2 Specifying The Cutting Tools And Calculating Cutting Data

Based on the operational sequence thus defined using the catalogue provided by Sandvik we can now 
select the appropriate cutting tools and calculate suitable cutting conditions:

4.2.1 For The First Operational Sequence– Milling Of The Top Protrusion:

Coromill® 390 – A ∅63mm OD cutter
Ordering code: RЗ90-063Q22-11M
Number of tooths: z = 6
Operating length of the tool: l1 = 40 mm
max ap = 10mm
max rpm = 20700
Inserts code: R390-11T308M-PM (from Page 38) wit coromant grade 1025
Recommended feed: fz = 0.15 mm/z for insert geometry PM and coromant grade =1025

Calculating cutting data
Assuming the processed material is steel of Brinell hardness НВ = 170, specific cutting force  
kc = 1700N/mm2, basic grades 1025 and fz = 0,15 mm/tooth cutting speed:

 Vc = 295 m/min
 Spindle speed: n = 1000 1000 295

3.14 63
Vc

dπ
× ×

=
× ×  

= 1494 rpm

Select a spindle speed: n = 1400 rpm
Calculate table feed: 

4.2.2 For The Second Operational Sequence – Milling Of The Cylindrical Pocket:

Coromill® 390 – A ∅25mm OD cutter
Ordering code: R390-025A-11M
Number of tooths: z = 3
Operational length of the tool: l1 = 40 mm
max ap = 10mm
max rpm = 36500
Inserts code: R390-11T308M-PM (from Page 38) wit coromant grade 1025
Recommended feed: fz = 0.15 mm/z for insert geometry PM and coromant grade =1025
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Calculate cutting data
Assuming the processed material is steel of Brinell hardness НВ = 170, specific cutting force 
kc = 1700N/mm2, basic grades 1025 and fz = 0,15 mm/tooth cutting speed:

 Vc = 295 m/min
 Spindle speed: n = 1000 1000 295

3.14 25
Vc

dπ
× ×

=
× ×

= 3757 rpm

Select spindle speed: n = 3700 rpm
Calculate table feed: 

4.2.3 For The Third Operational Sequence – Milling Of The Rectangular Pocket:

Solid carbide endmill – a ∅8mm OD cutter
Ordering code: R216.22-=08030CAC08L
Number of tooths: z = 2
Operational length of the tool: l3 = 29 mm
Grade 1010
max ap = 8mm

Calculate cutting data
For Dc = 8mm ⇒ feed/tooth is: fz = 0.06 ÷ 0.11 mm/z
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Select fz =0.06
Cutting speed is: Vc = 200 ÷ 400 m/min
Select Vc = 200 m/min
Spindle speed: n = 1000 200

3.14 8
×
×

= 7961 rpm
Select n = 7000 rpm
Calculate table feed:  mm/min
Axial step depth selected from page 62: ap = 0.8mm
Radial step depth (page 62): ae = 2mm

4.2.4 For The Fourth Operational Sequence – Drilling The Set Of 4 Holes With Diameter 20mm:

Carbide drill – ∅20mm OD
Ordering code: R415.5-2000-30-8C0
Operating length of the tool: l6 = 79 mm
Coromant grades 1040

Calculate cutting data
For drilling steel of Brinell hardness HB = 170, coromant grades 1040 and drill diameter  
Dc = 20mm ⇒ cutting speed Vc and feed fn are:
Vc = 60 – 100 m/min  ⇒ Select Vc = 80 m/min
fn = 0.18 ÷ 0.30 mm/r ⇒ Select fn =0.20 mm/r
Spindle speed: n = 1000 80

3.14 20
×
×

 = 1273rpm
Select: n = 1200rpm
Feed on Z-axis: 

4.2.5 For The Fifth Operational Sequence – Drilling The Set Of 7 Holes With Diameter 12mm:

Carbide drill – ∅12mm OD
Ordering code: R415.5-1200-30-8C0
Operational length of the tool: l6 = 55mm
Coromant grades 1040

Calculate cutting data
For drilling in steel with Brinell hardness HB = 170, coromant grades 1040 and drill diameter  
Dc = 20mm ⇒ cutting speed Vc and feed fn are:
Vc = 60 – 100m/min  ⇒ Select Vc = 80m/min
fn = 0.15 ÷ 0.25mm/r  ⇒ Select fn = 0.20mm/r
Spindle speed: n = 1000 80

3.14 12
×
×

 = 2123 rpm
Select: n = 2100rpm
Feed on Z-axis:

Download free eBooks at bookboon.com



CAD-CAM & Rapid Prototyping  
Application Evaluation

59 

Cam Application Evaluation: A Model Processing Case Study

4.2.6 For The Sixth Operational Sequence – Milling The Text Pocket “Jba”:

Since the minimum size of cutting tools specified in the Sandvik catalogue is 2mm, we select 
the required tool, a carbide endmill with diameter ∅1.2mm, specified in the catalogue of 
Mitsubishi Carbide [12].

Ordering code: EM-0012C227354
Number of tooths: z = 2
Operational length of the tool: l1 = 7 mm
max ap =0.3mm
Recommended feed: fz = 0.03 mm/z

Calculate cutting data
For a steel processing material of Brinell hardness НВ = 170 and fz = 0,03 mm/tooth cutting 
speed:

 Vc = 35 m/min
 Spindle speed: n = 1000 35

3.14 1.2
×
×

 = 9288 rpm, select n = 9000 rpm

Select spindle speed: n = 9000 rpm
Calculate table feed: 
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4.3 Pro/Engineer Part Manufacture Simulation

As soon as Pro/ENGINEER is started, it is recommended that Set Working Directory is selected from 
the FILE drop down menu and the directory is indicated where the current session of the program is 
going to save its working files. The mastsktfrg.prt. file is also saved in this directory.

Fig. 4.2 

4.3.1 Creating A New File

To create a new file for the machining data select File and from the drop down menu select New. In the 
new window that appears click on Manufacturing and NC Assembly (Fig. 4.2) specifying a Name for 
the newly created file in the appropriate field, in our case, Manufacturing. Click  OK to close the New 
window and open the main window of the Manufacturing module. Now Menu Manager is currently 
displayed in the upper right corner of the screen.

Manufacturing.asm is an assembly file (the Assembly of the Ref.Model and Workpiece), and in order for 
it to be complete, both its constituent components have to be defined:

•	 Ref Model.prt (Design Model) = The model to be machined – the mastsktfrg.prt file in our 
case.

•	 Workpiece (Stock) = A model representing the material from which the 
Ref Model will be machined.
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The blank file thus created is ready to store all the manufacturing information and the first data to  
be inserted into the file is the model to be machined. This is accomplished by the Command from  
Menu Manager

Mfg Model ⇒
Assemble ⇒
Ref Model The Open menu opens here allowing us to specify mastsktfrg.prt from the contents of the set 
directory and accept this selection.

Done/Return

The model is displayed as in Figure 4.3.

Fig. 4.3

The second piece of data to be inserted into the assembly file is the Workpiece.
From the Menu Manager select:

Download free eBooks at bookboon.com



CAD-CAM & Rapid Prototyping  
Application Evaluation

62 

Cam Application Evaluation: A Model Processing Case Study

Mfg Model ⇒
Create ⇒
Workpiece

Enter the name of the Workpiece file in the field – Workpiece (Figure 4.3) and accept entered data.

Solid ⇒
Protrusion ⇒
Extrude ⇒
Solid ⇒

Done ⇒
Oneside

Done Then use the cursor to click on the underside of the model and use Flip to change the direction 
of the arrow to point up. Select Okay, and Top – now appear the top flat planes of the design model 
and Pro/ENGINEER automatically goes in sketch operation mode (Fig. 4.4)
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 Fig. 4.4

From the Sketcher Toolbar on the left press the “Create an entity from an edge” button and select all the 
outer edges of the base protrusion (rectangle). Confirm using the bottom-most button on the Sketcher 
Toolbar – “Continue with the current section” and Pro/ENGINEER automatically exits sketch mode. 
When the profile is selected, define the extruded depth specifying it from the Menu Manager:

Blind and confirm by selecting
Done

In the prompt bar that appears, enter the value for depth 60mm using the keyboard and confirm using 
the “Accept value” button.

OK then
Done/Return.

The external profile/surfaces of the workpiece is then displayed in green (Figure 4.5).

Thus, these two components have been inserted into the assembly file machine_ex1.asm. Now we can 
start with the machining process.
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4.3.2 Defining A Co-Ordinate System For The Machine Tool

For sequences 1 thru 5 we will need a co-ordinate system the zero point of which will be used to set the 
zero position of the machine and the Z axis is coincident with the tool axis. To do this select Datum 
and then Co-ordinate System from the drop down menu Insert. Then, select from the Menu Manager:

 Fig. 4.5

3 Planes

Done and select 3 planes the crossing point of which will give the starting point of the new Co-ordinate 
System (Figure 4.6). The sub-menu commands – X-axis, Y-axis, Z-axis, Next, Previous, Reverse are 
used to set the required directions of axes and the new co-ordinate system is identified as ACS0.

 Fig. 4.6

As we mentioned earlier, a different co-ordinate system must be used for the workpiece in the last 
operational sequence 6. Therefore, another co-ordinate system – ACS1 is introduced as described above 
(Figure 4.7).
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 Fig. 4.7

4.3.3 Operation Setup

Before the machining sequences can be generated the type of machine and machine setup have to be 
defined for the sequence. All machining is done on a single 3-axis milling machine. However, the first 
5 sequences are machined using the ACS0 co-ordinate system, and the last sequence – using the ACS1 
co-ordinate system. Actually, the machining of the workpiece is performed on a single milling machine 
but using two different workpiece jigs. The machining operation is defined by a series of commands 
from the Menu Manager:
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MACHINING ⇒ OPERATION and the fields in the Operation Setup window are then filled-in (Figure 
4.8) as follows:

 Fig. 4.8

Operation Name: OP010

NC Machine: click on the icon on the right to open the Machine Tool Setup window, which is in turn 
filled-in (Figure 4.8):

Machine Name: MACH01
Machine Type: Mill
Number of Axis: 3Axis
Spindle ⇒ Main Spindle ⇒ Maximum Speed: 10000 rpm
Cutting Tools ⇒ Tool Change Time = 5 sec

OK and once the Machine Tool Setup window is closed, MACH01 automatically sets in the NC Machine 
field.
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 Fig. 4.9

To set the Machine Zero, click on the arrow and then click on the name of the co-ordinate system ACS0 
in the drawing and it is automatically entered in the dialogue box opposite to the Machine Zero.

•	 Retract is used to define a plane a set distance away, which the machine tool will start from and 
retreat to. The Z-axis has been defined to point vertically away from the top of the Workpiece. 
This axis can be selected to specify the retract plane. To specify the Retract Surface, click on 
the arrow and in the Retract Selection menu that appears indicate as follows:

•	 Along Z Axis Þ and enter a value of 20mm. Then OK for Retract Selection and
•	 OK for Operation Setup
•	 Done/Return

4.3.4 Creating The Machining Sequences

4.3.4.1 Milling

NC Sequence is title given to the elements that make up one cut. These elements include the type of tool, 
the surfaces or features to be machined, the speed (rpm) and feed rate at which the tool is to operate, 
and the cutter path.

The first cut is a profile cut to machine the top external surface of the model (surface 2 from Figure 
4.10). From the Menu Manager select:

Machining ⇒
NC Sequence ⇒
Machining ⇒
Profile ⇒
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 Fig. 4.10

From the SEQ SETUP dialogue box below the following terms must be ticked (see Figure 4.10): Name, 
Comments, Tool, Parameters, Surfaces. Co-ordinate system and Retract have already been specified in 
the Operation Setup above.

Done
A series of questions appear to help define the above terms and generate the NC Sequence:

Name: MILLING
Accept
Comments: Milling the upper profile of the model
OK
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Tools Setup dialogue box (Figure 4.11) is filled in as follows:

 Fig. 4.11

Name: T0001
Type: MILLING
Cutter Diameter: 63
Length: 40

Number of Teeth: 6
From Settings ⇒ Tool Number: 1
From Speeds-Feeds ⇒:
Speed: 1400 rev/min
Feed: 1260 mm/min
Axial Depth: 10 mm
Radial Depth: 48 mm

Having filled-in all the values, the tool can be added to the list of tools using the Apply button.

Values are taken from preliminary calculations as made in para 2 above.

Axial Depth is the maximum step of the tool along the Z-axis. For Radial Depth it is theoretically 
recommended to be kept at 0.8 of the tool diameter as a maximum.
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OK – confirm and close the Tools Setup dialogue box with all settings entered so far.

Then proceed with the settings for cutting conditions using the commands of the Menu Manager:

MFG Parameters ⇒
Set (Figure 4.12)
CUT_FEED: 1260
STEP_DEPTH: 8
SPINDLE_SPEED: 1400
COOLANT_OPTION: ON
CLEAR_DIST: 3

Done from Menu Manager confirms inserted cutting data and closes the Param Tree Menu.
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 Fig. 4.12

Now comes the definition of machined surfaces and Pro/ENGINEER automatically shows the SURF 
PICK from the Menu Manager:

Model
Done
Query Sel and then select one by one the external surfaces of the top protrusion (Figure 4.13)

 Fig. 4.13
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Done Sel ⇒
Done ⇒
Done Return

To view the cutter path/NC sequence:

Play Path ⇒
Screen Play ⇒

 Fig. 4.18

Done. The computer is generating here the machine simulation. Screen play depicts the track of the cutter 
axis, and playback speed is adjustable. Here we can see the generated cutter path, points of penetration 
and withdrawal of the tool and directions of movement.

To view the simulation in colour we can also perform a NC check (to do this it has to be enabled – and 
all required libraries are made available) and it needs to be set for each session.

NC Check ⇒

Display and the computer generates the simulation
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Run   to view.

The estimated time for the NC Sequence Milling and any other information can be taken from the report 
generated with the command

Seq Info ⇒

NC Sequence ⇒

Done Sel

 Fig. 4.15

It can be seen from this report that the cutting time for NC Sequence Milling is: t = 2.48443 min 
(Figure 4.15).

Pro/ENGINEER saves these reports in the Current Working Directory.

The command Done Seq finalises the current sequence setup and allows to continue with the next 
sequence.
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4.3.4.2 Milling The Cylindrical Pocket

Now a NC Sequence can be created to machine the cylindrical pocket in the design model. We must clarify 
here that Pro/ENGINEER provides for setting up a direct NC Sequence of a Pocketing type, but this only 
relates to Pockets already existing into the workpiece, which only require some additional machining.

In other words, in the Pocketing operation sequence, the tool is first machining the side surfaces 
performing several transitions and only finally machines the bottom of the workpiece but when the 
material in the middle of the machined workpiece is too dense, the tool will not have sufficient side 
cutting edge to remove this material (as seen from Figure 4.16). Therefore, it is far better here to use the 
volume-type NC Sequence since the cutter path there corresponds to the cutter path in the Pocketing 
NC Sequence in EZ-MILL. This will also facilitate the subsequent comparative analysis between the two 
applications.

 Fig. 4.16

Machining⇒

NC Sequence ⇒
New Sequence ⇒
Machining ⇒
Volume ⇒
Done

From Sequence Setup highlight and fill in the following fields:

Name: VOLUME1
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Accept
Comments: Milling the top cylindrical pocket
OK
Tools Setup dialogue box is filled in as follows:
Name: T0002

Type: MILLING
Cutter Diameter: 25
Length: 40
Number of Teeth: 3
From Settings ⇒ Tool Number: 2
From Speeds-Feeds ⇒:
Speed: 3700 rev/min
Feed: 1665 mm/min
Axial Depth: 10 mm
Radial Depth: 20 mm

Having filled in all the settings, add the new tool to the list of tools using the Apply button.

Values are taken from preliminary calculations made in para 2 above.
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The Radial Depth in the Volume NC Sequence is inherently limited by the Pro/ENGINEER application 
to a maximum of 0.5 of the diameter of the tool.

OK – confirm and close the Tools Setup dialogue box with all the settings thus entered.

 Fig. 4.18

The cutting conditions settings are then entered using the Menu Manager commands:

MFG Parameters ⇒
Set (Figure 4.17)
CUT_FEED: 1665
STEP_DEPTH: 5
STEP_OVER: 12
SCAN_TYPE: TYPE_SPIRAL
ROUGH_OPTION: ROUGH_&_PROF
SPINDLE_SPEED: 3700
COOLANT_OPTION: ON
CLEAR_DIST: 3
Done
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 Fig. 4.18

DEFINE VOL ⇒
Create Vol ⇒ specify volume name: Volume1 and press Accept.
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Sketch ⇒
Extrude ⇒
Solid ⇒
Done
One Side ⇒
Done
Query Select ⇒
Flip ⇒
Okay

From here we can highlight the circumference of the bottom of the cylindrical pocket in the sketch 
mode, confirm it, select

Blind ⇒

Done and specify the value of 30mm, which is the limit for the height of the volume thus created (i.e. a 
volume is being created to correspond to the cylindrical shape of the pocket being machined).

 Fig. 4.19

OK

Done/Return
To view the cutter path/NC sequence:
Play Path ⇒
Screen Play ⇒
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Done. The computer now generates the machine simulation and the cutter path (Figure 4.19).
Seq Info ⇒
NC Sequence ⇒
Done Sel
Cutting time for NC Sequence Volume1 is: t = 2.44602 min.
Done Seq finalises the current sequence setup.

4.3.4.3 Milling The Rectangular Pocket

This sequence setup is performed in a similar way to the previous sequence using the Volume type NC 
Sequence. The steps here are the same:

Machining⇒

NC Sequence ⇒
New Sequence ⇒
Machining ⇒
Volume ⇒
Done

From Sequence Setup, highlight and fill in the fields as follows:

Name: VOLUME2
Accept
Comments: Milling the top rectangular pocket
OK
Tools Setup dialogue box is filled in as follows:
Name: T0003
Type: MILLING
Cutter Diameter: 8
Length: 29
Number of Teeth: 2
From Settings ⇒ Tool Number: 3
From Speeds-Feeds ⇒:
Speed: 7000 rev/min
Feed: 840 mm/min
Axial Depth: 0.8 mm
Radial Depth: 2 mm

Once the settings are entered the new tool is added to the list of tools using the Apply button.
OK – confirms the settings thus entered and closes the Tools Setup dialogue box.
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Setting up the cutting conditions using the Menu Manager commands:

MFG Parameters ⇒
Set
CUT_FEED: 840
STEP_DEPTH: 0.8
STEP_OVER: 2
SCAN_TYPE: TYPE_SPIRAL
ROUGH_OPTION: ROUGH_&_PROF
SPINDLE_SPEED: 7000
COOLANT_OPTION: ON
CLEAR_DIST: 3
Done

Then we apply the above procedure to create the volume required for drilling Volume2, the height of 
the created volume set at 20mm.

OK
Done/Return

Download free eBooks at bookboon.com

Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

http://s.bookboon.com/EOT


CAD-CAM & Rapid Prototyping  
Application Evaluation

81 

Cam Application Evaluation: A Model Processing Case Study

To view the tool path/NC sequence (Figure 4.20):

 Fig. 4.20

Play Path ⇒
Screen Play ⇒
Done.

Cutting time for NC Sequence Volume2 is: t = 24.2657min.
Done Seq finalises the setup for the current sequence.

4.3.4.4 Drilling The Holes With Diameter 20mm

Before we create this operational sequence we specify the axes of model openings. This is performed 
from the Insert drop down menu (Figure 4.21) selecting:
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 Fig. 4.21

Datum⇒

Axis ⇒

Then from the Menu Manager:
Thry Cyl
Query Sel

Consecutively tick and confirm the cylindrical surfaces of holes, which also provides visualisation of 
their axes. We can then proceed with Drilling1 NC Sequence:

Machining⇒

NC Sequence ⇒
New Sequence ⇒
Machining ⇒
Holemaking ⇒
Done ⇒
Drill ⇒
Standard ⇒

Done. From the SEQ SETUP dialogue box below tick the following terms: Name, Comments, Tool, 
Parameters, Holes.
Done
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Consecutively define the above terms to generate the NC Sequence:

Name: Drilling20
Accept
Comments: Drilling the 4 holes with diameter 20mm
OK
Tools Setup dialogue box is filled in as follows:
Name: T0004
Type: DRILLING
Cutter Diameter: 20
Length: 79
From Settings ⇒ Tool Number: 4
From Speeds-Feeds ⇒:
Speed: 1200 rev/min
Feed: 350 mm/min
Axial Depth: 60 mm

The new tool is added to the list of tools using the Apply button.
The cutting conditions are then specified using the Menu Manager commands:
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 Fig. 4.22

MFG Parameters ⇒
Set (Figure 4.22)
CUT_FEED: 350
SCAN_TYPE: SHORTEST
SPINDLE_SPEED: 1200
COOLANT_OPTION: ON
CLEAR_DIST: 3

Done from Menu Manager confirms the inserted cutting data and closes the Param Tree Menu.

Now comes the time to define the holes to be drilled. By looking at the dialogue box there are a number 
of ways of defining the position of the holes in the design model to be machined.
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 Fig. 4.23

From the Hole Selection dialogue box, use the button Add to consecutively click on the axes of appropriate 
holes and accept. Selected axes are coloured in red and their designations appear in the field of the 
dialogue box (see Figure 4.23). A new dialogue box appears after Depth is depressed – the Hole Depth 
Criteria dialogue box, which is used to select

AUTO

OK. Then select OK from the Hole Selection dialogue box to close this box. From the Menu Manager
Done/Return
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To view the tool path/NC sequence (Figure 4.24):

 Fig. 4.24
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Play Path ⇒
Screen Play ⇒
Done.

Cutting time for NC Sequence Drilling20 is: t = 2.9347 min.
Done Seq finalises the setup for the current sequence.

4.3.4.5 Drilling The Holes With Diameter 12mm

Creating this operational sequence is similar to the previously described procedure with the only 
difference being in the provided data and hole axes.

Machining⇒

NC Sequence ⇒
New Sequence ⇒
Machining ⇒
Holemaking ⇒
Done ⇒
Drill ⇒
Standard ⇒
Done. From the SEQ SETUP dialogue box below tick the following terms: Name, Comments, Tool, 
Parameters, Holes.
Done
The above terms are defined consecutively to generate the NC Sequence:
Name: Drilling12
Accept
Comments: Drilling the 7 holes with diameter 12mm
OK
Tools Setup dialogue box is filled in as follows:
Name: T0005
Type: DRILLING
Cutter Diameter: 12
Length: 55
From Settings ⇒ Tool Number: 5
From Speeds-Feeds ⇒:
Speed: 2100 rev/min
Feed: 420 mm/min
Axial Depth: 30 mm
The new tool is added to the list of tools using the Apply button.
The cutting conditions are then specified using the Menu Manager commands:
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MFG Parameters ⇒
Set (Figure 4.22)
CUT_FEED: 420
SCAN_TYPE: SHORTEST
SPINDLE_SPEED: 2100
COOLANT_OPTION: ON
CLEAR_DIST: 3

Done from Menu Manager confirms the inserted cutting data and closes Param Tree Menu.

The 7 holes to be drilled of 12mm Dia are then defined following the procedure described above. The 
only difference is in specifying the depth of holes since these are blind holes. Therefore, we select Blind 
pressing the Depth button in the dialogue box – Hole Depth Criteria (see Figure 4.25)

 Fig. 4.25

Tick Z Depth in the Start Surface and specify the value 0 in the appropriate field.

Then tick Z Depth in End Surface and enter the value 30mm in the field.
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 Fig. 4.26

OK. Then select OK from the Hole Selection dialogue box to close. From the Menu Manager
Done/Return
To view the tool path/NC sequence (Figure 4.26):
Play Path ⇒
Screen Play ⇒
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Done.
Cutting time for NC Sequence Drilling12 is: t = 2.2233min.
Done Seq

Thus we finalise the setup procedures for all operational sequences performed in the first workpiece 
positioning arrangement employing specification of Machine Zero using the ACS0 co-ordinate system.

4.3.4.6 Milling The Text Pockets

As we already mentioned, to mill the letters “JBa” we need a different co-ordinate system ACS1 (see 
Figure 4.7) to perform the machining operation. In other words, the operation will be carried out on 
the same 3-axis milling machine (MACH01) we already defined but using another positioning of the 
machined workpiece, the text surface arranged perpendicular to the Z-axis of the tool.

In the Operation Setup dialogue box insert a new operation name – OP020 and the machine specification 
is the same (MACH01). We only need to position the Machine Zero relative to the ACS1 co-ordinate 
system by means of clicking on the arrow and then clicking on the ACS1 designation for the co-ordinate 
system in the drawing. The specified setting for the Machine Zero is automatically inserted in the 
corresponding dialogue box. We also define here a new Retract – new plane a set distance away, which 
the machine tool will start and retreat to. To position the Retract Surface click on the arrow and in the 
Retract Selection menu specify as follows:

Along Z Axis ⇒ and insert a value of 12mm. Then OK for Retract Selection and
OK for Operation Setup
Done/Return

We can use for this NC Sequence the pocketing function of Pro/ENGINEER, since the width (s) of 
milled letters is commensurate with 2×Dc, where Dc is the diameter of the tool.

Machining ⇒
NC Sequence ⇒
New Sequence ⇒
Machining ⇒
Pocketing ⇒
Done From the SEQ SETUP dialogue box below tick the following terms: Name, Comments, Tool, 
Parameters, Surfaces.
Done
Name: Pocketing
Accept
Comments: Milling the text pocket “JBA”
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OK
Tools Setup dialogue box is filled in as follows:
Name: T0006
Type: MILLING
Cutter Diameter: 1.2
Length: 7
Number of Teeth: 2
From Settings ⇒ Tool Number: 6
From Speeds-Feeds ⇒:
Speed: 9000 rev/min
Feed: 540 mm/min
Axial Depth: 0.2 mm
Radial Depth: 0.6 mm

Once the settings are specified, the new tool is added to the list of tools using the Apply button.

The values for the settings are taken from preliminary calculations made in para 2 above.

OK – confirms and closes the Tools Setup dialogue box with the settings thus specified.
The cutting conditions are then specified using the Menu Manager commands:
MFG Parameters ⇒

Set
CUT_FEED: 540
STEP_DEPTH: 0.2
STEP_OVER: 0.4
SCAN_TYPE: TYPE_3
SPINDLE_SPEED: 9000
COOLANT_OPTION: ON
CLEAR_DIST: 3

Done from Menu Manager accepts the inserted cutting data and closes the Param Tree Menu.
Now comes the time to define the machined surfaces and Pro/ENGINEER automatically displays SURF 
PICK from the Menu Manager:

Model
Done
Pick Many – this is a very useful for this particular case option of Pro/ENGINEER, allowing a multi 
selection of all letters simultaneously by means of including them in a window selection.
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 Fig. 4.27

Done Sel ⇒
Done ⇒
Done Return
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To view the tool path/NC sequence (Figure 4.27):

Play Path ⇒
Screen Play ⇒
Done.
To view the simulation:
NC check ⇒
Screen Display
Run to view.
Cutting time for NC Sequence Pocketing is: t = 11.0915min.
Done Seq

The files is saved from File ⇒ Save. A suggested name appears in the field (MANUFACTURING.MFG) 
⇒ Accept

Total cutting time for the part, as well as further information on many other manufacturing parameters 
can be displayed in the form of a report from the Info drop down menu

Info Manufacturing…⇒

and ticking Manufacturing Model in the appearing Manufacturing Info dialogue box. The report is 
generated either on the display or optionally, as a file.
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 Fig. 4.28

4.3.4.7 Total Machining Time

Total machining time by Pro/ENGINEER manufacturing simulation for the machined part:

T = 45.4457min

Thus, the concept of the machining the design model mastsktfrg.prt is complete.
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4.4 Ez-Mill Simulation Of The Manufacturing Of The Part

As we mentioned earlier, the same part, exported in advance as an iges file (mastskt.igs), will be machined 
using EZ-MILL in the same technological sequence and applying the same pre-calculated cutting data 
allowing us subsequently to draw up a comparative analysis.

To do this, we have to load the mastskt.igs file from the File drop down menu using the Open command 
(Figure 4.29).

 Fig. 4.29

4.4.1 Defining A Co-Ordinate System For The Machine Tool

It is exceptionally important for EZ-MILL to have an accurate definition of a co-ordinate system. In this 
particular case, two new co-ordinate systems have to be created similar to Pro/Engineer: one for the first 
5 operations, UCS1 and another one for milling the wording, USC2.
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 Fig. 4.30

Select New UCS… from the drop down menu View (Figure 4.30) and specify the designation: UCS1 in 
the appearing UCS ID dialogue box; accept with OK.

A co-ordinate system is displayed, which has to be accurately positioned relative to the X-, Y-axes. To 
do this:

First specify (in the fields on the right of the display) the co-ordinates for the new “0” and confirm with 
ENTER from the keyboard; then specify the co-ordinates of a point on the desired X-axis and confirm 
the selection with ENTER; specify the co-ordinates of a point on the desired Y-axis and confirm the 
selection with ENTER.
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 Fig. 4.31

The new co-ordinate system UCS1 is positioned as the current co-ordinate system (Figure 4.31). In a similar 
way, define the USC2 co-ordinate system to be used for milling the text on the workpiece (Figure 4.44).

4.4.2 Creating The Machine Work Steps

4.4.2.1 Milling

From the Curves drop down menu select New… and specify the name in the appearing Curve ID dialogue 
box: Crv1; then confirm the selection using OK. This automatically activates the Curve Chain mode 
(this mode could also be entered using the button in the upper right corner of the display). Position the 
cursor on the contour to be milled and double-click. The contour is coloured in blue and an indication 
of the direction of movement of the tool is given (Figure 4.32).

 Fig. 4.37

Click on the Work Step Data button (located in the horizontal setup bar in the bottom of the display, 
next to the Wk Step button– see Figure 4.29) and the Work Step Data dialogue box appears. This is not 
in active mode until a new work step is defined. From this box we can tick only:

Tool Info ⇒
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New opens the Work Step ID dialogue box where we can specify the name Milling and use OK to activate 
the Work Step Data dialogue box. Enter parameter settings as shown in figure 4.33. Cutting data is the 
same as calculated in para 2 above.

 Fig. 4.33

We must say here that we can do the same thing using the Automation ⇒ Contour drop down menu 
where the EZ Contour dialogue box appears (Figure 4.33). Having filled in the field and clicking on 
Advanced, the abovementioned Work Step Data dialogue box opens (Figure 4.32)
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 Fig. 4.34

Click on Close and the work step is complete.

Download free eBooks at bookboon.com

Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

http://s.bookboon.com/Subscrybe


CAD-CAM & Rapid Prototyping  
Application Evaluation

100 

Cam Application Evaluation: A Model Processing Case Study

From the Verify button located on the Verify toolbar (horizontal, upper in this case – see Figure 4.29) 
we can view the path of the tool along the contour only for this particular operation as ticked in the 
Selection list box.

From the Verify All button we can view the cutter path and the cutting time for all work steps defined 
so far (Figure 4.35).

The entire operation can be reviewed as a solid and in colour using the Preview 3D button.

The machining time for the first work step Milling is:
t = 2.74min (Figure 4.35)

 Fig. 4.35

4.4.2.2 Milling The Cylindrical Pocket

Define a new curve: Crv2 from drop down menu Curves employing the method explained above. 
Position the cursor on the contour of the upper circumference of the cylindrical pocket to be milled 
and double-click. It turns blue (Figure 4.36).
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 Fig. 4.37

Define a new work step: Pocket1

Fill in the Work Step Data Dialogue box (Figure 4.37). The Pocketing Cycle will be employed in this 
operation. Set the value 12mm for Step Over in the Cycle Data.

 Fig. 4.37

Click on Close to complete the work step.
Use the button Verify to view and verify the cutter path.
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The machining time for second work step Pocket1 is:
t = 1.96min.

4.4.2.3 Milling The Rectangular Pocket

Define a new curve: Crv3. Position the cursor on the upper contour of the rectangular pocket to be 
milled and double-click. The contour is coloured in blue (Figure 4.38).

 Fig. 4.38
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Define a new work step: Pocket2

Fill in the Work Step Data Dialogue box (Figure 4.39). The Cycle: Pocketing will again be used to perform 
this operation. Specify Carbide in the Tool Info ⇒ Material field since this is how the tool was initially 
specified in para 2 above. Set a value 2mm for Step Over in Cycle Data.

 Fig. 4.39

Clicking Close completes the work step.
Use the Verify button to view and verify the cutter path.
The machining time for the third work step Pocket2 is: t = 20.59min.

4.4.2.4 Drilling The Holes With Diameter 20mm

Define a new curve: Crv4. Position the cursor on the upper contour of each of the four holes to be 
drilled and double-click. EZ-MILL automatically builds the sequence in the cutter path itself observing 
the specified sequence of selection (Figure 4.40).
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 Fig. 4.40

Define the new work step: Holes20.

Fill-in the Work Step Data Dialogue box (Figure 4.41). To perform this operation we will use Cycle: 
Drill. Select Carbide for Tool Info ⇒ Material.

 Fig. 4.41

Close and the work step is complete.
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Use the Verify button to view and verify the cutter path.

The machining time for the fourth work step Holes20 is:
t = 0.72min.

4.4.2.5 Drilling The Holes With Diameter 12mm

Define a new curve: Crv5. Position the cursor on the upper contour of each of the seven holes to be 
drilled and double-click. EZ-MILL automatically builds the sequence in the cutter path itself observing 
the specified sequence of selection (Figure 4.42).

 Fig. 4.42

Define a new work step: Holes12.

Fill in the Work Step Data Dialogue box (Figure 4.43). For this operation, use Cycle: Drill. Select Carbide 
for Tool Info ⇒ Material.

Close and the work step is complete.

Use the Verify button to view the cutter path
The machining time for the fourth work step Holes12 is:
t = 0.55min.
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 Fig. 4.43
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4.4.2.6 Milling The Text Pockets

As mentioned earlier, we will use a different co-ordinate system for this particular work step and namely 
the UCS2 co-ordinate system as initially defined. It is very important when defining a new curve to 
specify the co-ordinate system to be used for the machining operation as the current system (see Figure 
4.44: USC: USC2). Otherwise, it will be hard to make an accurate selection of complex curves, such as 
the curves involved in the text, for example. Define a new curve: Crv6. Position the cursor on each of 
the closed loops shaping the upper contour of the letters “JBa” and double-click on each. The contour 
is then coloured in blue (Figure 4.44).

 Fig. 4.44

Define a new work step: Text_Pocket

Fill in the Work Step Data dialogue box (Figure 4.45). To perform this operation we will use Cycle: 
Pocketing. Select Carbide for Tool Info ⇒ Material.
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 Fig. 4.45

Specify the value 0.4mm for Step Over in the Cycle Data. Specify UCS2 for MCS ID in the appropriate 
field.

Click Close to complete the work step.
Use the Verify button to view and verify the cutter path.

The machining time for the sixth work step Text_Pocket is:
t = 11.79min.
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 Fig. 4.46
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4.4.2.7 Total Machining Time

Using the Verify All button we can view and verify the cutter path for all work steps (Figure 4.46) and 
also total machining time.

Total machining time by EZ-MILL manufacturing simulation for the machined workpiece is:
T = 38.34min

The button Prewiew 3D can be used to preview the settings as a solid and in colour. However, all settings 
for the workpiece required for the simulation process will have to be specified beforehand:

 Fig. 4.47

Machining ⇒ Stock & Optimisation Setup… and the appropriate dialogue box are filled in as shown 
in figure 4.47. The simulation process follows the sequence of the work steps (Figure 4.48) and the final 
result is shown in figure 4.49.

 Fig. 4.48
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The Save command in the File drop down menu saves the file as a geo- and a 3dp-file separately.

This completes the concept of machining of the design model mastskt.igs.

 Fig. 4.49

4.5 Usability and Available Features Of Pro/Engineer And Ez-Mill

4.5.1 File Organisation

When making a comparative analysis of the two software applications it is advisable to start with file 
organisation of operational files involved:

In Pro/ENGINEER a common mfg-file is used where the Ref.Model, Workpiece assembly and the 
machining process data is stored. In other words, this common manufacture.mfg file is made up of the 
following files: manufacture.asm, mastsktfrg.prt and workpiece.prt, whereas manufacture.asm is in turn 
an assembly of the mastsktfrg.prt and workpiece.prt files and this can be created as a separate file before 
the machining process is generated or within the manuacture.mfg file. Therefore, to be able to operate 
using the mfg-file it is necessary to have all 4 files available.

EZ-MILL operates with two files:

 - a geo-file comprising the model and the defined co-ordinate systems and curves; and a
 - 3dp-file comprising machining process data (work steps, tool parameters, cutter paths and 

cutting data).

Quantitatively, the file organisation of EZ-MILL is simpler than that for Pro/ENGINEER. However, Pro/
ENGINEER has the advantage that once the files have been created it is then sufficient to load only the 
mfg-file and it automatically loads the rest of the files and establishes the appropriate links. Whereas 
EZ-MILL requires that both files are opened.
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4.5.2 Operational Organisation

The operational organisation of the two software applications is another difference between them, 
although the basic technological principles of both applications are similar. Pro/ENGINEER is a CAM-
software of highest ranking and it requires higher skills and competence to apply. Its organisation is 
based on consecutively opening menus, submenus and dialogue boxes allowing to choose from multiple 
alternatives and a variety of tools. Each selection requires individual confirmation, which improves 
operational reliability, on one hand but slows down operations, on the other.

The EZ-MILL operation is simpler using primarily commands from toolbars and dialogue boxes. A 
useful feature is the bottom horizontal button bar from which one can monitor, select or edit some 
basic elements of the manufacturing process, such as: Layer, UCS, Curve, Work Step, Path, MCS. Other 
available characteristics are readily accessible and editable.

The same outcome results after several transitions within Menu Manager in Pro/ENGINEER but we 
must note here that once you get experienced this is very convenient, too.
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4.5.3 Usability And Available Features

Both applications are used to create a workpiece, but with Pro/ENGINEER this is saved in a separate 
file, while with EZ-MILL the created workpiece is not saved in a separate file. Nevertheless, it is still 
possible to define a workpiece similar to the procedures involved in Pro/ENGINEER if one starts from 
the very beginning using the tools available in the Geometry toolbar, but as it turned out this is not a 
compulsory exercise since we made the preliminary assumption that the size of the workpiece will be 
230×150×60mm.

Some of the terms applied in the two software applications are different as well but they still refer to the 
same thing, such as: NC Sequence (Pro/ENGINEER) and Work Step (EZ-MILL) – both are title given 
to the elements that make up one cut

 Fig. 4.50

Two alternatives of proceeding with the machining of the part exist in EZ-MILL:

•	 First is to pre-define all curves to be involved in the machining operations and these are 
saved as a geo- file, and then proceed with the definition of appropriate tools and cutting 
data and all ends up saved as a 3dp-file;

•	 Another alternative is to consecutively define each individual work step as a set of curves, 
toolpath, tool and cutting data. Having defined all work steps the file is then saved first as a 
geo-file and then also saved as a 3dp-file without any interruption to the current session.
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With Pro/ENGINEER the NC Sequences have to be defined consecutively one after the other, but the 
tools in the Tools Setup dialogue box for example, can be defined all at a time (see Figure 4.50).

Both applications are capable of selecting and importing tools from pre-existing libraries. Only that Pro/
ENGINEER provides for importing the processing NC machine from an existing ready-made library 
(such library can be created as a separate gph-file).

Defining the co-ordinate systems with the two applications is rather similar for both of them with the 
only difference being that Pro/ENGINEER provides a much higher number of alternative means to do 
this (see Figure 4.51).

 Fig. 4.51

Both applications allow for defining some conventional technological processes, such as contouring, 
pocketing, drilling, thread cutting, etc. Pro/ENGINEER provides for defining a greater variety and 
more complicated processes involving a higher number of parameters. For example, when Holemaking 
is selected a choice of 7 possible alternatives appears. EZ-MILL also provides for defining a sufficient 
variety of technological processes. But we must note here, that Pro/ENGINEER achieves better insight 
into the parameters being set and hence, improved definition of the entire machining process.
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 Fig. 4.52

Considering the particular part described in this report we should also mention the differences in the 
two applications when the pocketing operation is concerned. When this was applied with EZ-MILL and 
eventually viewed, the cutter path looked as shown in figure 4.52. For the same cylindrical pocket we 
used NC Sequence Volume in Pro/ENGINEER and the cutter path is the same for the same cutting data 
(see Figure 4.53). If we had used Pocketing with Pro/ENGINEER the result would have been different 
(as was already shown in figure 4.16 and explained in para 3.4.2).
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 Fig. 4.53

Another significant difference is that while Pro/ENGINEER specifies some parameters on its own based 
on the defined surfaces, EZ-MILL requires values to be specified regardless of the model. For example, 
when Pocketing is specified and the bottom plane is selected, Pro/ENGINEER does not require you to 
specify depth, while EZ-MILL will operate until the set value is reached. In other words, Pro/ENGINEER 
provides a higher level of intuitively.

Both applications provide viewing capabilities, including three-dimensional views, but again here Pro/
ENGINEER gives an advantage in the means of controlling the viewing function – by means of adjusting 
the speed, using the Pause characteristic, applying the dynamic control capability, etc. Moreover, it 
provides for playing back the history of the entire manufacturing file – from the Utilities drop down 
menu ⇒ Model Player.

Fig. 4.54

Additionally, both applications provide for calculating the cutting time for each individual operation 
and also the total cutting time. But the additional information for the machining process generated in 
the form of various reports by Pro/ENGINEER is highly varied and larger in quantity.
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However, EZ-MILL features a very useful informational facility that provides for even editing specified 
cutting data: from the Machining drop down menu ⇒ Show Spread Sheet. The table which appears 
here is editable even for multi-optional parameters (see Figure 4.54). This allows for every work step to 
be re-defined from here.

4.6 Innovative Approaches To Optimise The Manufacturing Process Plan

If we analyse the cutting times for every NC sequence of the machining process, defined in the course 
of the simulation (para 3 thru 4), it is obvious that the operation of the longest duration is the milling 
of the rectangular pocket. With Pro/ENGINEER the cutting time for this operation is:

t = 24.2657min

Moreover, the Volume type of sequence is employed here to remove the excessive material from the 
pocket. Meanwhile, tool diameter is limited to the rounded corners radii of 5mm. Using this sort of tool 
with a small diameter and relatively small axial step (max. 0.8mm – refer to Sandvik catalogue, page 62) 
naturally leads to significant increase in the total machining time for this component part.

What can we do using the capabilities of the CAM application software Pro/ENGINEER to optimise the 
manufacturing process plan in order to reduce cutting time and hence, reduce the manufacturing cost?

Utilising some clever alternatives and efficient ways provided by the application we can investigate how 
this reflects on both cutting time and the overall time, facilities and additional capabilities involved in 
the usage of Pro/ENGINEER:

NC Sequence named Volume2 will be replaced by two new NC Sequences Pocket2_1 and Pocket2_2, and 
the first sequence will use a ∅25mm Dia tool, and the second sequence – a ∅8mm Dia tool. Additionally, 
the specified sequence type Volume will be replaced by Pocketing.

1. Pocket2_1: From Menu Manager

Machining ⇒
NC Sequence ⇒
New Sequence ⇒
Machining ⇒
Pocketing ⇒
Done From the SEQ SETUP dialogue box below tick the following terms: Name, Comments, Tool, 
Parameters, Surfaces.
Done
Name: Poketing2_1
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Accept
Comments: Milling the rectangular pocket with tool 25mm
OK

Tools Setup – It is important to note here that the tool and its parameters (tool name T0002) have 
already been specified in the previous NC Sequence. Therefore, we only have to click on T0002 and it 
is selected as current (Figure 4.55). Moreover, tool type and parameters are saved in a t0002.tpm file. 
This is accomplished by clicking on the “Save tools parameter to a file” button. Thus, the customer can 
build his own library to use for his future convenience.

 Fig. 4.55

OK – confirms the setting and closes the Tools Setup dialogue box
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MFG Parameters ⇒

Another important moment – select Retrieve instead of Set and from the Open dialogue box select the 
pocket2_1.mil file (see Figure 4.56). Settings are loaded automatically and it is not necessary to fill in 
the appropriate fields again. The mil-file is created in advance and saved in a library while defining one 
of the previous sequences. Of course, we can always select Set and edit all settings. All these provisions 
make the process very convenient and contribute to the unification of parameters providing opportunities 
for multiple comparative playbacks.

Mil-file is save by selecting Save in the MFG PARAMS submenu (see Figure 4.56).

 Fig. 4.56

Done and Pro/ENGINEER automatically suggests that we define the surfaces to be processed:

Another important moment here is that instead of Model we select:

Mill Volume ⇒
Select Vol
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Opens the Selection Tools dialogue box where we click on Volume2. It turns red. (see Figure 4.57). 
There are many alternatives here as we can also proceed with Pick and continue as described earlier 
with Model ⇒ Done ⇒ Query Select

 Fig. 4.57

However, the optimum choice is Select Vol as Volume2 has already been defined and saved in para 3.4.3. 
so it can be used as set. Confirm the setting with Select.
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Done Sel⇒
Done Return⇒

Play Path⇒

Screen Play

The cutting tool removes material only in a few strokes (see Figure 4.58) and the time it takes is:

t = 0.288min.

Some material is still left in the corners because of the relatively big tool radius. This will be later removed 
by the next tool, a 8mm diameter T0003.

 Fig. 4.58

2. Pocket2_2:

The procedure is similar to Pocket2_1 with only a few differences:

Name: Poketing2_2
Accept
Comments: Milling the rectangular pocket with tool 8mm
OK
Tools Setup – just click T0003 and it becomes current
OK – confirms and closes the Tools Setup dialogue box
MFG Parameters ⇒
Retrieve and from dialogue box Open tick the pocket2_2.mil file (see Figure 4.56).
Done
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Select Volume2 observing absolutely the same procedure as for Pocket2_1 (see Figure 4.57).
Done Sel⇒
Done Return⇒

Play Path⇒

Screen Play

The tool removes the rest of the excessive material in an optimum manner (see Figure 4.59) for the time of:
 t = 5.307min

 Fig. 4.59

In other words, the total time for machining the rectangular pocket is:

tp2 = 0.288min + 5.307min = 5.595min (was 24.2657min)

This is a triple reduction.
Then the total machining time for all sequences by Pro/ENGINEER simulation is:

T = 26.775min (was 45.4457min)

Moreover, optimisation of the machining tool path is achieved, which will actually form two concentric 
contours of the two tools (Figures 4.58 and 4.59). The fact that two sequences are performed instead of 
one has no negative effect as no replacement of tools is involved since sequences 2 and 3 use the same 
type of tool, T0002.
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To be able to achieve absolutely the same cutter path with EZ-MILL, the Pocket2 work step shall be 
divided into three separate operations (Figure 4.60) with cycles:

 Fig. 4.60

 - Pocketing using tool T0002 (∅25mm); t = 0.62min;
 - Contouring using tool T0003 (∅ 8mm); t = 4.56min;
 - Zig Zag along the bottom using tool T0003 (∅ 8mm) t = 1.12min;

In other words, the total time required to machine the rectangular pocket is:

tp3 = 0.62min + 4.56min + 1.12min = 6.30min (was 20.59min)
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The total machining time by EZ-MILL simulation is:

T = 24.05min (was 38.34min)

The results are very similar. Minor differences result from some parameters, such as rapid strokes, etc., 
which are associatively specified by Pro/ENGINEER, unless user specified.

 Fig. 4.61

We should mention here the opportunities to select the type of trajectory of the tool for various types of 
NC sequences (Pro/ENGINEER). This is defined by the submenu MFG PARAMS ⇒ Set for each sequence. 
For example, if we consider the second NC sequence (this is a Volume type sequence), the possible 
selections for a cutter path can be seen in the Param Tree dialogue box, the SCAN_TYPE field (Figure 
4.61). Figure 4.62 shows a playback and views of three of them: SPIRAL_MAINTAIN_CUT_DIRECTION, 
TYPE_ONE_DIR, TYPE_1_CON- NECT (Figure 4.16, para 3.4.2.shows a view of TYPE_SPIRAL).

 Fig. 4.62

Download free eBooks at bookboon.com



CAD-CAM & Rapid Prototyping  
Application Evaluation

125 

Cam Application Evaluation: A Model Processing Case Study

Additionally, if the Param Tree dialogue box is switched to Advanced View mode, a number of 
parameters appear comprising the following groups: Names, CUT OPTION, CUT PARAMETERS, 
FEED, MACHINE, ENTRY/EXIT. Specifying these parameters provides complete definition of the 
machining process.

As we mentioned earlier, the EZ-MILL application provides a more limited number of alternative 
specifications and the same can be performed there resulting in the same cutting path. For example, 
two possibilities exist for this particular cylindrical pocket. From dialogue box Work Step data (or from 
Machining ⇒ Spreadsheet) select Cycle: Zig Zag or Pocketing for work step Pocket1 (Figure 4.63). For 
the first selection, the machining time is 2.48min, and for the second selection, t = 1.96min.

 Fig. 4.63

The discussion included in para 6 above was an example of the use of CAM-software innovative 
approaches to optimise the manufacturing Process plan.

4.7  Reiterative Approach To Optimise The Machining Sequences And Minimise 
Machining Time

Optimising machining sequences and minimising machining time and cost can also be achieved by 
optimising some of the parameters used in defining sequences. An example of a route that can be used 
to achieve this involves another simulation of the machining process of the model again using Pro/
ENGINEER and involving the optimisation described in the previous paragraph, and namely, replacing 
the Volume2 sequence with two sequences – Pocket2_1 and Pocket2_2:

1. In the first NC Sequence Milling optimisation possibilities are present only in step depth, 
which can be varied from 8mm to 10mm. This will reduce the number of transitions from 4 
to 3. 10mm is the maximum specified step depth for this type of tool.

Machining ⇒
NC Sequence and from NC SEQ LIST select 1. Profile ⇒ SEQ SETUP where Parameters 
shall be ticked.
Done ⇒
Set
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In the Param Tree dialogue box: CUT PARAM – STEP_DEPTH is set from 8 to 10. As a result 
of this modification operation time is now:

 t = 1.8837min (was 2.48443min)

2. In the second NC Sequence Volume1 in the Param Tree dialogue box:
CUT PARAM – STEP_DEPTH: 8mm (was 5mm);

 t = 1.64568min (was 2.44 602min)

3. In the third NC Sequence Pocket2_1 in the Param Tree dialogue box:
CUT PARAM – STEP_DEPTH: 8mm (was 5mm);

 t = 0.24024min (was 0.288min)

4. In the fourth NC Sequence Pocket2_2 the tool operates with the maximum parameters 
recommended in the appropriate specifications and under optimum conditions, so no 
modifications are required:

 t = 5.3311min
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5. No modifications shall be introduced in the fifth NC Sequence Holes20 – the tool here 
operates with the parameters recommended in the appropriate specifications and under 
optimum conditions:

 t = 2.9347min

6. No modifications are introduced in the NC Sequence Holes12 either:

 t = 2.22333min

7. In the NC Sequence Pocketing in the Param Tree dialogue box:

CUT PARAM – STEP_OVER: 0.6mm (was 0.4mm);
CUT OPTION – SCAN_TYPE: TYPE_SPIRAL (was TYPE_3)

 t = 10.5833min (was 11.0915min)

Then the total machining time for all sequences by Pro/ENGINEER simulation is:

T = 24.842min (was 45. 4457min)

Similarly, we can use the same procedure when using EZ-MILL. It is even easier and faster to pre-define 
parameters with this application and especially when the facility Spread Sheet is used as mentioned in 
para 5 (Figure 4.54). The results with machining times will be similar to above.

In principle, we could also vary such parameters as feed and axial step and this will further reduce 
machining time but on the other hand, will have a negative effect on tool wear, will reduce tool life cycle 
and increase the risk of tool breaking. This will in turn result in adding cost to manufactured products 
and eliminate the benefits of reduced machining time.
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4.8 Conclusions

The experience gained in this chapter has confirmed the huge benefit brought by CAM applications in 
developing a design for the manufacturing process. Essential conclusions can be drawn based on the 
experience working with the two software applications Pro/Engineer and EZ-MILL:

•	 File organisation of the two CAM software applications is very similar; a file comprising the 
model and its parameters is usually used and another file (or files) comprising all the data 
used to define the machining process.

•	 The organisation of operations is very specific to individual applications but dialogue boxes 
and menus are primarily used in both.

•	 A significant issue when working with CAM software applications is the correct definition 
of required co-ordinate systems;

•	 High significance is also given to tool definition. Provisions are made for both importing of 
ready-made libraries and for creating new ones, as well as editing existing ones.

•	 Based on common technological principles, CAM software applications operate using 
certain types of processes, the diversity and degree of parametric definition of which are 
different for different applications.

•	 Both applications require specification of machined surfaces or contours but they employ 
different ways of defining them, Pro/Engineer for example, allowing for volumes to be 
defined as well.

•	 Very useful are memorising features used to save the parameter sets of definitions (of 
machines, tools, cutting data, volumes, etc.).

•	 A powerful tool facilitating the optimisation process is the tool path simulation feature, 
machining time calculation feature, process verification feature, as well as the editing and 
pre-definition facility.

•	 Reports generation and making analyses (especially with Pro/Engineer) are also useful 
features.

If we compare these two applications we could say that Pro/Engineer is a CAM-software application of 
the highest ranking. It offers a wider set of modules, tools and capabilities and one needs to be much 
more skilled and familiar with it to be able to use it. On the other hand, EZ-MILL is faster and simpler 
to operate with. It is a simpler CAM software application suitable for smaller series production and for 
component parts of simple configuration.
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5  Reverse Engineering & Rapid 
Prototyping

The present chapter describes an assessment of the “state of the art” in respect to rapid prototyping 
processes. Based on a variety of reference material on latest developments of modern RP techniques, 
it is also aimed at identifying the reasons why these processes have developed and identifying the key 
features of the process.

5.1 Brief Rp Flashback

The first commercial process was presented at the AUTOFACT show in Detroit (US) in November 
1987, by a company called 3D Systems, Inc. At that time, the process was very inaccurate and the choice 
of materials was limited. Therefore, the parts obtained where considered prototypes. Like in software 
engineering, a prototype is something to look at, serves as a basis for discussion but cannot be used for 
anything “serious’’, i.e. in a production environment [1].
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Since then, Rapid Prototyping Technologies (RPT) have taken enormous strides. Nowadays, there are 
over 30 processes, some of which are commercial, while others are under development in research 
laboratories [1]. The accuracy has improved significantly, and the choice of materials is relatively large, 
to the extent that the term prototype is becoming misleading; the parts are more and more frequently 
being used for functional testing or to derive tools for pre-production testing. It is very likely that a new 
term, or one of the numerous other expressions that are floating around, will replace it in the future.

Rapid prototyping is the name given to a host of related technologies that are used to fabricate physical 
objects directly from Computer-Aided Design (CAD) data sources. These methods are generally 
similar to each other in that they add and bond materials in layerwise-fashion to form objects [1]. This 
is directly the opposite of what classical methods such as milling or turning do. Objects are formed in 
those processes by mechanically removing material.

These “three dimensional printers” allow designers to quickly create tangible prototypes of their designs, 
rather than just two-dimensional pictures. Such models have numerous uses. They make excellent visual 
aids for communicating ideas with co-workers or customers. In addition, prototypes can be used for design 
testing [1]. Designers have always utilised prototypes; RP allows them to be made faster and less expensively.

In addition to prototypes, RP techniques can also be used to make tooling (referred to as rapid tooling) 
and even production-quality parts (rapid manufacturing). For small production runs and complicated 
objects, rapid prototyping is often the best manufacturing process available [2].

 Fig. 5.1: CAD solid object

Rapid prototyping isn’t necessarily very rapid and doesn’t necessarily have to do with prototypes, either. Speed 
is relative: The processes can shave weeks to months off a design cycle, but still may require many hours 
to fabricate a single object. Prototypes for design evaluation are often made using these processes, but the 
technology also is beginning to address the direct production of final useful parts and assemblies, and injection 
moulding and other types of tools. Therefore “rapid” is a relative term. Most prototypes require from three to 
seventy-two hours to build, depending on the size and complexity of the object. This may seem slow, but it is 
much faster than the weeks or months required to make a prototype by traditional means such as machining. 
These dramatic time savings allow manufacturers to bring products to market faster and more cheaply [2].
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 Fig. 5.2: Converted in STL format object

Because RP technologies are being increasingly used in non-prototyping applications, the techniques 
are often collectively referred to as solid free-form fabrication, computer automated manufacturing, or 
layered manufacturing. The latter term is particularly descriptive of the manufacturing process used by 
all commercial techniques. A software package “slices” the CAD model into a number of thin (~0.1 mm) 
layers, which are then built up one atop another [2]. Rapid prototyping is an “additive” process, combining 
layers of paper, wax, or plastic to create a solid object. In contrast, most machining processes (milling, 
drilling, grinding, etc.) are “subtractive” processes that remove material from a solid block. RP’s additive 
nature allows it to create objects with complicated internal features that cannot be manufactured by 
other means [2].

5.2 The Basic Process

Although several rapid prototyping techniques exist, all employ the same basic five-step process. The 
steps are:

•	 CAD Model Creation: First, the object to be built is modelled using a CAD software 
package (Fig. 1).

•	 Conversion to STL Format: The various CAD packages use a number of different 
algorithms to represent solid objects. To establish consistency, the STL (Standard 
Triangulation Language -Stereolithography, the first RP technique) format has been adopted 
as the standard of the rapid prototyping industry [3]. The second step, therefore, is to 
convert the CAD file into STL format (Fig. 2). This format represents a three-dimensional 
surface as an assembly of planar triangles, like the facets of a cut jewel. The file contains the 
coordinates of the vertices and the direction of the outward normal of each triangle. Since 
the STL format is universal, this process is identical for all of the RP build techniques [3].

•	 Slice the STL File: In the third step, a pre-processing program prepares the STL file to be 
built. Several programs are available, and most allow the user to adjust the size, location and 
orientation of the model. The pre-processing software slices the STL model into a number of 
layers from 0.01 mm to 0.7 mm thick, depending on the build technique [3]. The program 
may also generate an auxiliary structure to support the model during the build. Each PR 
machine manufacturer supplies their own proprietary pre-processing software.
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•	 Layer by Layer Construction: The fourth step is the actual construction of the part. Using 
one of several techniques RP machines build one layer at a time from polymers, paper, or 
powdered metal [3].

•	 Clean and Finish: The final step is post-processing. This involves removing the prototype 
from the machine and detaching any supports. Some photosensitive materials need to be 
fully cured before use. Prototypes may also require minor cleaning and surface treatment. 
Sanding, sealing, and/or painting the model will improve its appearance and durability [4].

5.3 Applications Of Rapid Prototyping

Rapid prototyping is widely used in the automotive, aerospace, medical, and consumer products 
industries. Although the possible applications are virtually limitless, nearly all fall into one of the 
following categories: prototyping, rapid tooling, or rapid manufacturing.

Prototyping: As its name suggests, the primary use of rapid prototyping is to quickly make prototypes 
for communication and testing purposes. Prototypes dramatically improve communication because most 
people, including engineers, find three-dimensional objects easier to understand than two-dimensional 
drawings. Such improved understanding leads to substantial cost and timesavings [4].

Prototypes are also useful for testing a design, to see if it performs as desired or needs improvement.
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Rapid Tooling: A much-anticipated application of rapid prototyping is rapid tooling, the 
automatic fabrication of production quality machine tools. Tooling is one of the slowest and 
most expensive steps in the manufacturing process, because of the extremely high quality 
required. Rapid tooling can be divided into two categories, indirect and direct [5].

 - Indirect Tooling: RP parts are used as patterns for making moulds and dies. RP models can 
be indirectly used in a number of manufacturing processes:

 - Vacuum Casting, Sand Casting, Investment Casting, Injection moulding.
 - Direct Tooling: To directly make hard tooling from CAD data is the one of most important 

for rapid tooling. Realisation of this objective is still several years away, but some strong 
strides are being made:

 - RapidTool: A DTM process that selectively sinters polymer-coated steel pellets together to 
produce a metal mould. The mould is then placed in a furnace where the polymer binder 
is burned off and the part is infiltrated with copper. The resulting mould can produce up to 
50,000 injection mouldings [5].

 - Laser-Engineered Net Shaping (LENS) is a process that will create metal tools from CAD 
data.

 - Direct AIM (ACES Injection Moulding): A technique from 3D Systems in which 
stereolithography-produced cores are used with traditional metal moulds for injection 
moulding of high and low density polyethylene, polystyrene, polypropylene and ABS  
plastic [6].

 - In another variation, cores are made from thin SLA shells filled with epoxy and aluminium 
shot.

 - LOMComposite: There are ceramic composite materials for Laminated Object 
Manufacturing. LOMComposite parts would be very strong and durable, and could be used 
as tooling in a variety of manufacturing processes [6].

 - Sand Moulding: At least two RP techniques can construct sand moulds directly from CAD 
data. DTM sells sand-like material that can be sintered into moulds, while Soligen 3D 
Printing machines can produce ceramic moulds as well [7].

Rapid Manufacturing: A natural extension of RP is rapid manufacturing (RM), the automated production 
of saleable products directly from CAD data [6]. Currently only a few final products are produced by 
RP machines, but the number will increase as metals and other materials become more widely available. 
RM will never completely replace other manufacturing techniques, especially in large production runs 
where mass-production is more economical [7].

For short production runs, however, RM is much cheaper, since it does not require tooling. RM is also 
ideal for producing custom parts tailored to the user’s exact specifications.
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The other major use of RM is for products that simply cannot be made by subtractive (machining, 
grinding) or compressive (forging, etc.) processes. This includes objects with complex features, internal 
voids, and layered structures.

RPT in Industrial Design: When comparing industrial design applications to the manufacturing 
of toolings, the role of dimensional accuracy is not as significant as the quality of the surface. The 
stairstepping effect can be reduced in several ways. Firstly, good software tools can help minimise the 
problem. Secondly, post-treatment can be applied, and in this case, the part is usually polished. Finally, 
the processes can be improved to virtually eliminate the problem. For instance, the technology developed 
by Laser 3D can use a layer thickness as low as resulting in parts with no noticeable stairstepping effect 
to the naked eye. Soligen claims that their process can also eliminate the stairstepping using different 
principles [8].

RPT in Medical Applications: Applying RPT in the medicine is a new and exciting field. Many 
applications have become possible due to the convergence of three distinct technologies, namely Medical 
Imaging, Computer Graphics and CAD, and RPT [8].

Computer-Assisted Tomography (CT) and Magnetic Resonance Imaging (MRI) provide high-resolution 
images of internal structures of the human body, e.g. bone structures and organs. Once these images 
have been processed by suitable software tools, it is possible to transfer the result to a RP process and 
obtain a physical part, called a medical model (Figure 5.3).

 Fig. 5.3: Obtaining medical models from scanned images

Together, these technologies provide doctors and surgeons with new tool-physical models of human internal 
structures-to better plan and prepare complex surgeries. If the surgeries can be carried out more successfully, 
less cost associated to post-operative treatment are expected, in addition to reduced risks, reduced patient 
suffering, and improvements in the quality of the results.

Another recent application has been the manufacturing of a human chromosome [8].
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5.4 Rapid Prototyping Techniques

The new rapid prototyping technologies are additive processes. They can be categorised by material: 
photopolymer, thermoplastic, and adhesives.

Photopolymer systems start with a liquid resin, which is then solidified by discriminating exposure to a 
specific wavelength of light. Thermoplastic systems begin with a solid material, which is then melted and 
fuses upon cooling. The adhesive systems use a binder to connect the primary construction material [8].

The names of specific processes themselves are also often used as synonyms for the entire field. Among 
these are stereolithography (SLA for stereolithography apparatus), selective laser sintering (SLS), fused 
deposition modelling (FDM), laminated object manufacturing (LOM), solid ground curing (SGC), inkjet 
systems and three dimensional printing (3DP).

Several processes are now most widely distributed in the United States, Europe, and Asia; many more 
are in the developmental stages.
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5.4.1 Stereolithography (Sla)

5.4.1.1 Principle Of Operation

Patented in 1986, stereolithography started the rapid prototyping revolution and is a free form fabrication 
technology, developed by 3D Systems, Inc. Due to its accuracy and surface finish, it has become the most 
popular of the rapid prototyping methods.

The technique builds three-dimensional models from liquid photosensitive polymers that solidify when 
exposed to ultraviolet light. Stereolithography builds plastic parts or objects a layer at a time by tracing 
a laser beam on the surface of a vat of liquid photopolymer. This class of materials, originally developed 
for the printing and packaging industries, quickly solidifies wherever the laser beam strikes the surface 
of the liquid [8].

5.4.1.2 Process Description

The STL file of the proposed component is sliced by software. Each slice is then hatched on to the surface 
of a photosensitive ultraviolet curable resin with a “swinging” laser. Where the focused beam of the laser 
strikes the surface the resin is cured. Each slice is typically 0.1mm thick. After each layer is cured the 
partially built model is lowered in to a vat of resin by one layer thickness. A recoating blade then lays a 
thin film of uncured resin over the surface of the resin [9].

Overhanging portions of the model are supported by a lattice that is automatically generated and 
incorporated into each layer by the software. The model is built on a support lattice to prevent direct 
adhesion to the recoating table, thus allowing the model to be removed relatively easily on completion 
of the build. On completion of the build the model is carefully removed from the platform and washed 
in a solvent to remove the uncured resin from the surface [9]. The model is then placed in a ultraviolet 
oven to harden any uncured resin. The process is shown in Figure 5.4.

 Fig. 5.4: Schematic diagram of the stereolithography process

Download free eBooks at bookboon.com



CAD-CAM & Rapid Prototyping  
Application Evaluation

138 

Reverse Engineering & Rapid Prototyping

Because it was the first technique, stereolithography is regarded as a benchmark by which other 
technologies are judged. Early stereolithography prototypes were fairly brittle and prone to curing-
induced warpage and distortion, but recent modifications have largely corrected these problems [9].

5.4.1.3 Advantages

Stereolithography generally is characterised with:

Good dimensional accuracy – The process is able to maintain the dimensional accuracy of the built 
parts to within ± 0.1mm.

•	 Good surface finish – Glass-like finishing can be obtained on the top surfaces of the part 
although stairs can be found on the side walls and curve surfaces between build layers [9].

•	 Unattended building process – The system is very stable. Once started the process is fully 
automatic and can be unattended until the process is completed.

•	 The process is of high resolution and capable to build parts with rather complex details
•	 3D Systems Inc. have developed a software called “Quickcast” for building parts with hollow 

interior which can be used directly as wax pattern for investment casting
•	 It is the most widely used process in the RP field [9].

5.4.1.4 Disadvantages

Stereolithography also have some disadvantages, as follows:

•	 Curling and warping – The resin absorb water as time goes by resulting curling and warping 
especially in the relatively thin areas [10].

•	 Relatively high cost (US$200–500K) – However, it is anticipated that the cost will be coming 
down shortly.

•	 Narrow range of materials – The material available is only photosensitive resin of which the 
physical property, in most of the cases, cannot be used for durability and thermal testing.

•	 Post curing – The parts in most cases have not been fully cured by the laser inside the vat. A 
post curing process is normally required [10].

High running and maintenance cost – The cost of the resin and the laser gun are very expensive. 
Furthermore, the optical sensor requires periodical fine-tuning in order to maintain its optimal operating 
condition, which will be considerable, expensive [10].
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Fig. 5.5: Objects in different prototyping states

5.4.1.5 Application Field

•	 Prototypes for concept models (Fig. 5.5);
•	 Form-fit for assembly tests and process planning;

 Fig. 5.6: SLA RP Prosthesis

•	 Models for investment casting, replacement of the wax pattern;
•	 Patterns for metal spraying, epoxy moulding and other soft tooling;
•	 A medical application of the stereolithography in surgery to produce equipment; design and 

manufacturing of orthopaedic implants (Fig. 5.6) [10].

5.4.2 Selective Laser Sintering (Sls)

5.4.2.1 Principle Of Operation

Developed by Carl Deckard for his master’s thesis at the University of Texas, selective laser sintering was 
patented in 1989. CAD files are transferred to the system, where they are sliced and drawn, one cross-
section at a time, by applying the laser beam to a thin layer of powder. The laser beam fuses the powder 
particles to form a solid mass that matches the CAD design. As each layer is drawn, the prototypes take 
shape within the system.
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5.4.2.2 Process Description

The technique, shown in Figure 5.7, uses a laser beam to selectively fuse powdered materials, such as 
nylon, elastomer, and metal, into a solid object. Parts are built upon a platform which sits just below the 
surface in a bin of the heat-fusible powder. A laser traces the pattern of the first layer, sintering it together. 
The platform is lowered by the height of the next layer and powder is reapplied. This process continues 
until the part is complete. Excess powder in each layer helps to support the part during the build [10].

 Fig. 5.7: Schematic diagram of selective laser sintering
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The finished objects have a matte, powdery surface. Objects made by SLS using nylon powder have a 
powdery white appearance. The surface is absorbent and marks easily, but otherwise the objects are fairly 
robust, and can be made with moving parts such as hinges. Models can be sanded down and painted if 
required, to give a smooth finish. Commercial systems are made by DTM Corporation and EOS Gmbh. 
SLS models can be made in wax, sand or steel powder as well as nylon [10].

Materials most often used in selective laser sintering are polycarbonate and nylon. For polycarbonates, 
densities of 75–92% of that of the standard injection-moulded material can be obtained; for nylon 
even better values, 87–93%, have been realised. Another material that is well suited for the process is 
investment casting wax. This allows the direct construction of wax patterns for foundry use. The SLS 
process provides the most functional rapid prototype available [10].

5.4.2.3 Advantages

•	 Capable of producing the toughest part compared with other process
•	 Large variety of material can be used, including most engineering plastic, wax, metal, 

ceramic, etc.
•	 Parts can be produced in short time, normally at a rate of up to 1 inch per hour
•	 No post curing of parts is required
•	 During the building process, the part is fully supported by the powder and no additional 

support is required.
•	 Parts can be built on top of others [10].

5.4.2.4 Disadvantages

•	 The powder material requires to heat up to the temperature below the melting point before 
the building process, which takes about 2 hours. After building the parts, it also takes 5 to 
10 hours to cool down before removing the parts from the powder cylinder.

•	 The smoothness of the surface is restricted to the size of the powder particles and the laser 
spot resulting that the surface of the part is always porous. Smooth surface can only be 
obtained by post processing [10].

•	 The process chamber requires continuous supply of nitrogen to provide a safe environment 
for the sintering process to be taken place resulting expensive running cost of the process.

•	 Toxic gases will be generated from the process, which leads to an environmental issue.

5.4.2.5 Application Field

Considering the density results just mentioned, selective laser sintering is particularly suited to build 
fully functional prototypes in polycarbonates and/or nylons, that closely approximate the mechanical 
properties found in the final (i.e., injection-moulded) products. Such models can be tested before any 
capital outlay for the construction of injection moulds becomes necessary [10].
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 Fig. 5.8: Processes SLS LaserForm; SLS DuraForm; SLS CastForm PS

5.4.3 Fused Deposition Modeling (Fdm)

5.4.3.1 Principle Of Operation

FDM is the second most widely used rapid prototyping technology, after stereolithography. Fused 
deposition modelling builds a product up in thin layers of thermoplastic wire-like filaments. There’s no 
need for messy liquid photopolymers, no powders, no lasers.
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5.4.3.2 Process Description

In this technique, filaments of heated thermoplastic are extruded from a tip that moves in the x-y plane. 
Like a baker decorating a cake, the controlled extrusion head deposits very thin beads of material onto 
the build platform to form the first layer. The platform is maintained at a lower temperature, so that the 
thermoplastic quickly hardens. After the platform lowers, the extrusion head deposits a second layer 
upon the first. Supports are built along the way, fastened to the part either with a second, weaker material 
or with a perforated junction [10].

Several materials are available for the process including ABS and investment casting wax. ABS offers good 
strength, and more recently polycarbonate and polysulfone materials have been introduced which extend 
the capabilities of the method further in terms of strength and temperature range. Support structures are 
fabricated for overhanging geometries and are later removed by breaking them away from the object. A 
water-soluble support material which can simply be washed away is also available [11].

Fig. 5.9: Schematic diagram of fused deposition modelling

The method is office-friendly and quiet. FDM is fairly fast for small parts on the order of a few cubic 
inches, or those that have tall, thin form-factors. It can be very slow for parts with wide cross sections, 
however. The finish of parts produced with the method have been greatly improved over the years, but 
aren’t quite on a par with stereolithography. The closest competitor to the FDM process is probably 
three-dimensional printing [11]. However, FDM offers greater strength and a wider range of materials 
than at least the implementations of 3DP from Z Corp. which are most closely comparable.
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5.4.3.3 Advantages

The advantages of FDM Rapid Prototyping are follows:

•	 Quick and cheap generation of models;
•	 Different colours are possible;
•	 Easy and convenient date building;
•	 There is no worry of possible exposure to toxic chemicals, lasers, or a liquid polymer bath [11];
•	 The system does not waste material during or after producing the model, it does not require 

clean-up;
•	 Materials can be changed quickly.

5.4.3.4 Disadvantages

•	 Restricted accuracy due to the shape of the material used: wire of 1,27 mm diameter.
•	 Supports may be required
•	 Part strength is weak perpendicular to build axis.
•	 Temperature fluctuations during production could lead to delamination [11].

5.4.3.5 Application Field

•	 Model for operation and functional part testing;
•	 Design model for assessing a product’s final appearance and geometry;
•	 After assembling the parts, the working of complete products can be evaluated;
•	 Investment casting and injection moulding.

Fig. 5.10: Fully functional model built by fused deposition modelling   
Complex model built of a number of separate parts each made by fused deposition modelling

5.4.4 Laminated Object Manufacturing (Lom)

5.4.4.1 Principle Of Operation

In this technique, developed by Helisys of Torrance, CA, layers of adhesive-coated sheet material are 
bonded together to form a prototype. The original material consists of paper laminated with heat-activated 
glue and rolled up on spools.
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 Fig. 5.11: Laminated object manufacturing
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5.4.4.2 Process Description

Profiles of object cross sections are cut from paper or other web material using a laser. A focused laser 
cuts the outline of the first layer into the paper and then cross-hatches the excess area (the negative space 
in the prototype). The paper is unwound from a feed roll onto the stack and first bonded to the previous 
layer using a heated (laminating) roller (Figure 5.11), which melts a plastic coating on the bottom side 
of the paper. The profiles are then traced by an optics system that is mounted to an X-Y stage. After 
cutting of the layer is complete, excess paper is cut away to separate the layer from the web. Waste paper 
is wound on a take-up roll [11]. The method is self-supporting for overhangs and undercuts. Areas of 
cross sections which are to be removed in the final object are heavily cross-hatched with the laser to 
facilitate removal (Figure 5.12).

 Fig. 5.12: Cubes separating from the object’s surface

Helisys developed several new sheet materials, including plastic, water-repellent paper, and ceramic 
and metal powder tapes. The powder tapes produce a “green” part that must be sintered for maximum 
strength [12]. While there are limitations on materials, work has been done with plastics, composites, 
ceramics and metals. Some of these materials are available on a limited commercial basis.
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5.4.4.3 Advantages

LOM has following advantages:

•	 The row materials costs are relatively low;
•	 The process is much faster than competitive techniques;
•	 The process produces virtually no internal stress and associated undesirable deformation [12];
•	 LOM Slice possesses the robust capacity of dealing with imperfect STL files, created with 

discontinuities, in which the surfaces of STL objects are not closed completely;
•	 Best suited for building large parts.

5.4.4.4 Disadvantages

•	 The stability of the objects is limited by the bonding strength of the glued layers;
•	 As the procedure is not well suited for manufacturing parts with thin walls in the 

z-direction, the application range is approximately restricted to complex parts [10];
•	 Hollow parts, like bottles, can not be built.

5.4.4.5 Application Field

 Fig. 5.13: Some LOM’s applications

•	 LOM objects are used as precise patterns for secondary tooling processes such as rubber 
moulding, sand casting and direct investment casting [8];

•	 LOM objects can be used to make spray metal moulds for prototype injection moulding.
•	 LOM’s geometrical stability, inherent precision and high resolution lends itself to the plaster 

casting process.
•	 The durability and rigidity of LOM objects make them suitable for low to medium volume 

vacuum forming of thin plastic components [8].
•	 LOM objects can be used also for limited testing and as visual models.
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There are also variations, developed by many others companies and research groups, which seek to 
increase speed and/or material versatility by cutting the edges of thick layers diagonally to avoid stair 
stepping.

5.4.5 Solid Ground Curing (Sgc)

5.4.5.1 Principle Of Operation

Developed by Cubital (Israel), solid ground curing (SGC) is something of a hybrid between 
Stereolithography and laser printing. The machine makes an image of the cross-section of the model 
on a glass plate, using similar methods to those employed in a laser printer [8]. The surface of the liquid 
photo-polymer is solidified by exposing it to light from a UV lamp (similar to stereolithography), using 
the glass plate as a mask which allows the light through to expose the liquid surface in selected areas. 
Unlike SLA, SGC cures an entire layer at a time.

5.4.5.2 Process Description

Figure 5.14 depicts solid ground curing, which is also known as the solider process. First, photosensitive 
resin is sprayed on the build platform. Next, the machine develops a photomask (like a stencil) of the 
layer to be built. This photomask is printed on a glass plate above the build platform using an electrostatic 
process similar to that found in photocopiers. The mask is then exposed to UV light, which only passes 
through the transparent portions of the mask to selectively harden the shape of the current layer.
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 Fig. 5.14: Schematic diagram of solid ground curing

After the layer is cured, the machine vacuums up the excess liquid resin and sprays wax in its place to 
support the model during the build. The top surface is milled flat and then the process repeats to build 
the next layer [8]. When the part is complete, it must be de-waxed by immersing it in a solvent bath. 
SGC machines are quite big and can produce large models.

5.4.5.3 Advantages

•	 Multiple parts can be positioned within the entire working envelop resulting high 
throughput;

•	 No support structure is required as the wax support the structure in all directions [7];
•	 Part complexity does not effect speed, however volume does;
•	 Each layer is fully cured resulting that the dimension is very stable with no shrinkage effect 

after the process and requires no post-curing process;
•	 Capable to build even the most complicated parts without much difficulty;
•	 Build session can be interrupted and erroneous layer can be erased [8].

5.4.5.4 Disadvantages

•	 The process is rather complicate which required skilled people to look after and unattended 
operation is not possible;

•	 The resin consumption is disregard of the size of the cross section of the parts but only 
depended on the number of layers resulting that it is too expensive for parts with small 
cross sectional area [9];

•	 The machine is very large (Fig. 5.15) and machining is noisy;
•	 Very few materials available;
•	 High equipment cost (over US$500,000) made it not easily to be justified.
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 Fig. 5.15: SGC machine Solider 5600

5.4.5.5 Application Field

Application field of Solid Ground Curing is similar to SLA and can produce parts with even more 
complicated details:

Form-fit for assembly tests and process planning; prototypes for concept models (Fig. 5.16); models for 
investment casting, replacement of the wax pattern; soft tooling; and medical application [11].

 Fig. 5.16

5.4.6. Ink-Jet Printing

5.4.6.1 Principle Of Operation

This technology is also called Three Dimensional Printing (3DP). Actually, there is a broad range of 
diverse technologies that fall into the ink-jet printing category, but all rely on squirting a build material 
in a liquid or melted state, which cools or otherwise hardens to form a solid on impact.
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5.4.6.2 Process Description

 Fig. 5.17: Schematic diagram of Ink-jet printing technology

Solidscape, Inc.’s inkjet method (Thermal Phase Change Inkjets) uses a single jet each for a plastic build 
material and a wax-like support material, which are held in a melted liquid state in reservoirs (see 
Figure 5.17). The liquids are fed to individual jetting heads which squirt tiny droplets of the materials as 
they are moved in X-Y fashion in the required pattern to form a layer of the object [12]. The materials 
harden by rapidly dropping in temperature as they are deposited. After an entire layer of the object is 
formed by jetting, a milling head is passed over the layer to make it a uniform thickness. Particles are 
vacuumed away as the milling head cuts and are captured in a filter. The process is repeated to form 
the entire object. After the object is completed, the wax support material is either melted or dissolved 
away [13].
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5.4.6.3 Advantages

The most outstanding characteristic of the Solidscape system is the ability to produce extremely fine 
resolution and surface finishes, essentially equivalent to CNC machines.

5.4.6.4 Disadvantages

However, the technique is very slow for large objects. While the size of the machine and materials are 
office-friendly, the use of a milling head creates noise which may be objectionable in an office environment. 
Materials selection also is very limited [13]. All thermal phase change inkjets have material limitations 
and make fragile parts.

5.4.6.5 Application Field

The applications range from concept models to precise casting patterns for industry and the arts, 
particularly jewellery.

5.4.7 Multijet Modelling (Mjm)

5.4.7.1 Principle Of Operation

One example of the technology variations available in these so-called phase change inkjets is provided by 
3D Systems. This company produces an inkjet machine, called the ThermoJet Modeler (formerly Actua), 
based on MultiJet Modelling (MJM) technology, which utilises several hundred nozzles.

Fig. 5.18: MJM – 3D Systems
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5.4.7.2 Process Description

The completed CAD solid model is transferred to a STL file, ready for the build process. Parts are built by 
an innovative process that uses a MultiJet Modelling (MJM) head to apply a thermopolymer material in 
three dimensions. The print head comprises multiple jets that build the model layer by layer. If the part 
is larger than the MJM head the build platform will reposition within the Y-axis such that the process 
may continue (Fig. 5.19). MJM head is illustrated in Figure 5.18 [13].

The material deposition process of the 3D printer is very similar to that of the ink jet printer and is 
illustrated in Figure 5.18.

As the development stage processes near manufacture, costs of change increase accordingly. Changing 
a functional prototype has the disadvantage of high cost and delay to production. Desktop 3D printing 
is the best solution to concept modelling where changes can be introduced early within modelling. 
Introducing a change in the concept phase can be easily absorbed.

Fig. 5.19

5.4.7.3 Advantages

Three-dimensional printing is often used as a direct manufacturing process as well as for rapid 
prototyping. Desktop rapid prototyping machines are based on desktop printing technology [14]. They 
are no larger than a photocopier, run just as cleanly and quietly and have a number of advantages over 
other rapid prototyping techniques:

•	 the machines have lower purchasing costs,
•	 parts are cheaper to construct
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Three-dimensional printing offers the advantages of speedy fabrication and low materials cost. In fact, 
it’s probably the fastest of all RP methods. Recently colour output has also become available.

5.4.7.4 Disadvantages

There are limitations on resolution, surface finish, part fragility and available materials. Models 
constructed using the 3D printer method are weak and can easily be damaged and distorted [14]. In 
this case these models can be strengthened by infiltrating with wax, and ink can be added to the initially 
transparent wax to produce parts that have a variety of colours.

Some rapid prints need post-processing, either for design integrity or aesthetic appearance. Typical post-
processing involves sanding or painting, making the part more appealing for presentational purposes. 
Completed models are initially fragile and require dipping into molten wax or an epoxy which introduces 
durability.

5.4.7.5 Application Field

One application for 3D Printing is to create ceramic moulds for metal casting. Another application is 
to print metal parts directly [14]. New efforts are directed at making structural ceramic parts and parts 
for medical application within the human body.
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Fig. 5.20: Injection moulding tools made by 3D Printing; Ceramic mould made by 3D Printing and an orthopaedic knee casting 
poured into a similar mould;. Colour-coded objects, such as this model of a compressor.

5.4.8 Paper Lamination Technology (Plt)

5.4.8.1 Principle Of Operation

This technique is a variation on LOM and was developed by Kira Corporation. Paper Lamination 
Technology (PLT) uses a knife to cut each layer instead of a laser and applies adhesive to bond layers using 
the xerographic process. The Paper Lamination Technology (PLT) uses an additive/subtractive process 
by which layers of paper (for use with copy machine) are bonded together by high heat and pressure 
and then uses computerised cutter to cut to desired profiles [14]. Similar to the LOM technology, the 
part does not go through a phrase change.

 Fig. 5.21: PLT System
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5.4.8.2 Process Description

Fig. 5.22: PLT process

Products are made by paper lamination as follows:

•	 Paper Feed Unit (Figure 5.22-1): A sheet feed mechanism orients the one sheet on the target 
block.

•	 Hot Press System (Figure 5.22-2): Using high pressure, the hot press moves the target block 
with sheet up a hot plate. All the area of the sheet is applied adheres to the target block. 
The amount of movement up to the hot plate is measured. If deviation in sheet and resin 
thickness is identified, automatic compensation is made to insure dimensional integrity of 
the completed 3D model [14].

 Fig. 5.23

•	 Cutting Process (Figure 5.22-3): The PC generates plotting data based on section data of the 
target shape. A mechanical cutter cuts the top layer of the target block along the contour of 
the section [14].

•	 Processes are repeated rapidly and accurately. Unnecessary partions are removed (Figure 5.23).
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5.4.8.3 Advantages

•	 High lamination pressure makes the model 25% harder than wood (as substitutes);
•	 Minimal internal strain and no curing;
•	 Use commercial paper and toner;
•	 Low running cost and relatively small size of equipment;
•	 Requires no special operation techniques [15].

5.4.8.4 Disadvantages

•	 The models must be sealed and finished with paint or varnish to prevent moisture damage. 
It can be time consuming to remove extra material for some geometries [15].

•	 Like method, based on laminated object manufacturing will be limited in what can be 
accomplished because of the raw material thickness.
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 Fig. 5.24

5.4.8.5 Application Field

The field of PLT applications is too large (Fig. 5.24): Modelling, Prototypes, Sand Casting, Vacuum 
Casting Silicon Mould Application, 3D-GIS Models, Industrial Models, Vacuum Casting, Wind Volume 
Test Models.

5.4.9 Laser Engineered Net Shaping (Lens)

Laser Engineered Net Shaping (LENS) is a technology that is gaining in importance and in early stages of 
commercialization. A high power laser is used to melt metal powder supplied coaxially to the focus of the 
laser beam through a deposition head (Figure 5.25). The laser beam typically travels through the centre of 
the head and is focused to a small spot by one or more lenses. The X-Y table is moved in raster fashion to 
fabricate each layer of the object. The head is moved up vertically as each layer is completed [15]. Metal 
powders are delivered and distributed around the circumference of the head either by gravity, or by using a 
pressurised carrier gas. An inert shroud gas is often used to shield the melt pool from atmospheric oxygen for 
better control of properties, and to promote layer to layer adhesion by providing better surface wetting [15].

Fig. 5.25: Schematic diagram of Laser Engineered Net Shaping 
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A variety of materials can be used such as stainless steel, Inconel, copper, aluminium etc. Of particular 
interest are reactive materials such as titanium. Materials composition can be changed dynamically 
and continuously, leading to objects with properties that might be mutually exclusive using classical 
fabrication methods.

The strength of the process lies in the ability to fabricate fully dense metal parts with good metallurgical 
properties at reasonable speeds. Objects fabricated are near net shape, but generally will require finish 
machining. They have good grain structure, and have properties similar to, or even better than the 
intrinsic materials.

 Fig. 5.26: LENS process

LENS has fewer material limitations than SLS and doesn’t require secondary firing operations as some 
of those processes do, however [10].

5.4.10 Photopolymer Phase Change Inkjets

Recently, inkjet technology has been extended to operation with photopolymers resulting in systems 
that have both fast operation and good accuracy.

Objet Geometries Ltd., an Israeli company, announced the QuadraTM system in early 2000. It’s potentially 
a promising replacement for stereolithography. The process is based on photopolymers, but uses a wide 
area inkjet head to layerwise deposit both build and support materials. It subsequently completely cures 
each layer after it is deposited with a UV flood lamp mounted on the printhead [12]. The support material, 
which is also a photopolymer, is removed by washing it away in a secondary operation. The low price, 
approximately $65K, and specifications that are similar to laser-based stereolithography systems costing 
ten times as much make this an important technology to watch [11].

In July, 2002, 3D Systems introduced a similar photopolymer-based system called the InVisionTM.
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5.4.11 Electroset Technology

rapid prototyping technology. Electroset Synergistic Technologies Corporation holds the international 
patent rights [13]. Electroset rapid prototyping technology uses electric fields to shape objects. The 
typical electroset system consists of a personal computer (with graphics system), an electrode printer, 
and a high-voltage power supply.

This process takes several steps. First, a cross section of the object is generated on the computer. The 
computer then sends the image to the printer where the electrodes are formed into the shape of the 
image and attached to a frame (the frame is a sheet of conductive material such as aluminium foil). 
When all frames are complete, they are sandwiched into a mould, which is connected to a power supply 
[14]. The mould is immersed into a bath of Electroset fluid and energised. Upon energising, the fluid 
between the electrodes solidifies. The mould is withdrawn from the bath and excess fluid drains from 
the object. After trimming off the mould framing, the part is complete. The hardware required for a 
manually operated system of this type would have a price of about $5000. Any added automation would 
drastically raise the price [16].

A unique feature in this technology is the ability to electrically predetermine the material properties of 
the cured object. Material properties that are programmable include density, compressibility, hardness, 
and adhesion. The material properties can be programmed during Electrosetting by controlling the 
maximum applied current independently from the maximum applied voltage [16].

Common Electroset materials used include silicone rubber, polyester, polyurethane, and epoxy.

5.4.12 Photochemical Machining

Photochemical Machining, a process similar to SLA but still under development, uses two intersecting 
laser beams to form a three-dimensional prototype out of a photopolymer block. Research on this process 
by Battelle (Columbus, OH) and Formigraphics Engine Corporation (Berkely, CA) dates back to the 
1960s with related patents [15].

Because of the use of two lasers, this method could be the most versatile photopolymer-based rapid 
prototyping process. One beam moves in the x-y plane. The other beam moves in the y-z plane. Each 
beam has different wavelengths. The combination of the intersecting beams polymerises the material, 
rather than a single laser beam solidifying an area on the surface of the material [15]. Forming a part 
in the z-axis no longer needs to be done in layers. Initialising the laser’s movement in any set of X-, Y-, 
Z-coordinates allows the ability to trace the part in three dimensions rather than two. This capability 
would reduce prototyping time even more.
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Areas in need of research and development are in the lasers and in the photopolymer [15]. The lasers 
need improvement in the selectivity of the laser sensitises and in quality of the beam. Also, work needs 
to be done on the speed and efficiency of the beams; it currently takes almost a minute for the beam 
to cure the polymer. Work also remains to be done in developing a polymer that will not cure by the 
exposure of a single laser beam [15].

5.4.13 Design-Controlled Automated Fabrication (Descaf )

The Design-Controlled Automated Fabrication (DESCAF) process builds prototypes a layer at a time 
by exposing liquid polymer to ultraviolet light through a photomask. An entire layer is solidified 
simultaneously. The SOMOS Solid Imaging System is similar to SLA but differs in the photopolymer 
used and the laser system [15]. The material is a white, low shrinkage, proprietary resin with properties 
similar to silicon rubber. This material is claimed to have high photospeed, low shrinkage and warpage, 
wide exposure latitude, flexible and homogeneous photoformed parts, and good layer-to-layer adhesion. 
The SOMOS system employs an argon-ion laser with high-precision scanning in a raster pattern and 
high-speed beam modulation [15]. The Solid Creation System (SCS) uses similar technology used in 
Stereolithography, but has the ability to build larger parts. The largest system has a build area of 40x32x20 
inches.
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5.4.14 Liquid Metal Jet Printing (Lmjp)

The Liquid Metal Jet Printing (LMJP) is a revolutionary process technology in additive solid freeform 
manufacturing process. It can build mechanical parts and electronic interconnects in an additive manner. 
Unlike spray forming, LMJP is similar to ink jet printing where every individual molten droplet is 
controlled and printed to specific location. By changing the orifice size, the system will dispense molten 
spheres of metal with diameters from 100 to 1000 microns [15].

At the moment research work is focused on development of an aluminium-printing device for rapid 
prototyping of near net shaped mechanical parts. Previous research work has included metal ball 
generation and capture, solder masks, and jetting copper for printing circuits [15].

5.4.15 Sparx – Hot Plot

Sparx AB of Molndal, Sweden, has introduced a rapid prototyping system very similar to the Laminated 
Object Manufacturing technology developed by Helisys. This Swedish system is called “Hot Plot.” It is 
currently the least expensive commercial system but does require a considerable amount of operator 
assistance [14]. It consists of a flat-bed plotter equipped with a heated cutting electrode and a mounting 
fixture.

The process begins with the mathematical generation of cross-sectional data from the three-dimensional 
CAD model. Next, the polystyrene sheet material is manually positioned on the plotter bed. This material 
has been coated with pressure-sensitive adhesive and backed by removable foil. The electrode cuts the 
outline of the cross-section [14]. The operator picks up the sheet representing the layer and affixes it on 
a mounting fixture. The foil backing is peeled off to expose adhesive for the next layer. Excess material 
is manually removed from the plotter bed to accommodate the next sheet. This process continues until 
completion of the part.

This sheet material, supplied by Sparx, is currently 0.04 in. thick. It costs two dollars per sheet ($50 per 
inch of part). The software interface accommodates AutoCAD, but cannot yet accommodate the .STL 
file. This system is best suited for visual modelling since the material is very weak and the layers are 
very thick [14].
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5.5 RP Process Evaluation

5.5.1 Accuracy

Stairstepping: Since rapid prototyping builds object in layers, there is inevitably a “stairstepping” effect 
produced because the layers have a finite thickness. Those methods that produce the thinnest layers have 
less stairstepping than others, but it’s almost always visible. The technology that produces the thinnest 
layers is based on inkjets [13]. These machines have the advantage that each layer is milled flat after it’s 
deposited and as little as 0.0005 inches of material can be left as a layer thickness. Of course, that makes 
the building process very slow. Stereolithography can also produce thin layers, although not quite at 
that level and this feature is mainly used to make small parts in the several millimetres or less range.

Everything else produces more pronounced stairstepping. Obviously methods based on one or another 
form of laminated object manufacturing (LOM) will be limited in what can be accomplished because 
of the raw material thickness. Methods based on powders, for example selective laser sintering (SLS) 
or three dimensional printing (3DP), have the finite size of the powder as a lower limit [13]. Layer 
thickness will almost always be greater than the minimum particle size. In some experimental methods 
of LOM, variable layer thickness is used and cutting means may be employed that shapes edges so that 
less stairstepping is visible.

Absolute accuracy/Precision: Absolute accuracy can be defined as the difference between an intended 
final dimension and the actual dimension as determined by a physical measurement. In addition to 
those for linear dimensions, there are accuracy specifications for such features as hole sizes and flatness. 
In a few fields absolute accuracy isn’t very important, but in most areas it’s a critical issue [13]. Taking 
stereolithography as a starting point, as shown in the table, one can get at least a qualitative idea. A good 
rule is that stereolithography will produce accuracy results of about ± 0.004 inches over a dimension of 
about six inches. LOM and powder-based methods will generally be somewhat less accurate than that. 
The inkjet methods are somewhat better. Since the final numbers depend on the geometry of the part, 
the particular dimension measured, the material used and other factors it’s difficult to make a more 
definitive statement [13].

5.5.2 Finishes

The finish and appearance of a part are related to accuracy, but also depend on the method of RP 
employed. Here again, taking stereolithography as “very good,” getting about the same differentiation 
among the methods produced by accuracy as described above. Technologies based on powders have 
a sandy or diffuse appearance, sheet-based methods might be considered poorer in finish because the 
stairstepping is more pronounced.
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Resolution refers to the minimum feature size that can be faithfully reproduced and is related to the 
finish and appearance and accuracy that can be achieved. For most RP systems, resolution is in the “few 
mils” range [11]. Specially modified systems are available that can reproduce much finer features, but 
they are limited in the size of the parts they can fabricate. Inkjet based systems from Solidscape and 
Sanders International are capable of very high resolution.

In any case, it will probably be necessary to sand, paint, fill, polish, infiltrate a secondary material to 
decrease porosity, or perform other operations on the part before it can be used [11].

5.5.3 Secondary Operations

In many cases, plastic or other soft material-based rapid prototyping parts can be used directly, or after 
relatively minor finishing operations. Parts made by stereolithography are frequently not completely 
cured when removed from the machine. Final cure is effected in a box called a post-cure apparatus 
(PCA) where the part may be bathed in UV light while on a turntable [10].

Parts from processes such as three dimensional printing (3DP) can be very fragile and might not be able 
to take normal handling or shipping stresses. They are often infiltrated with cyanoacrylate adhesive or 
wax as a secondary operation to make them more durable.
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All rapid prototyping methods, which directly produce metal parts will almost certainly require final 
machining and other secondary operations before acceptable final finishes and tolerances are achieved, 
although there may be a few exceptions based on the requirements for a particular part. Before they can 
be final-machined, metal and ceramic parts made by selective laser sintering (SLS) must usually undergo 
a thermal baking cycle to lightly consolidate them into a “brown” part, and then they may undergo a 
final thermal cycle to sinter and infiltrate them with a material to make them fully-dense [10].

Powder-based methods of rapid prototyping are self-supporting for features such as overhangs and 
undercuts; the excess powder is simply shaken off or vacuumed away. All other methods require a support 
structure of some kind which is fabricated right along with the part. This must subsequently be removed 
in a secondary operation which may require considerable effort and time [12].

Stereolithography parts require the supports to be cut off and the areas they were attached to finished, 
often by hand.

Inkjet based systems either use a hair-like support structure, as in the case of MultiJet Modeling (MJM), 
or a second support material which is removed with a solvent. The hair-like structures can be brushed 
away and the remaining down-facing surfaces cleaned up manually [13].

Fused deposition modelling (FDM) may use either a snap-away support structure made from a second 
material that doesn’t stick to the part material, or a water-soluble support structure [14].

Laminated object manufacturing (LOM) may require labour-intensive work to “de-cube” trapped volumes 
or other portions of the part that need to be removed. It may be necessary to perform this delicate 
operation with a hammer and chisel (Figure 12). Methods of LOM have been under development for 
several years that avoid this issue, but there is nothing commercially available yet.

5.5.4 Speed

All RP technologies are fairly slow taking from hours to even days to output a part. Nevertheless, this is 
still often much faster overall than if the same part were made using subtractive CNC. It is not unusual 
with some complex parts to save literally weeks of machining time. The use of the term “rapid” is relative 
and not absolute.

Raster-based RP methods are generally faster than ones that fabricate each layer in a vector fashion, and 
ones that build in thicker layers are faster than those making thin ones. Thus, three dimensional printing 
(3DP) as exemplified by Z Corporation’s products are the speediest – quicker than stereolithography and 
far faster than some inkjets or fused deposition modelling (FDM) [14]. Inkjets which use just a couple 
of nozzles and make high resolution objects are probably the slowest in any side by side race. But that’s 
not the complete story.
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Even though one RP method may be considerably slower than another in a side by side fabrication race, 
that doesn’t necessarily mean that it would lose. One also has to take into consideration the ancillary 
secondary operations that have to be performed [14]. Fused deposition modelling (FDM) may be slower 
than stereolithography in making a particular part, but if can simply wash away the support structure 
it might be possible to be in business a lot sooner.

5.5.5 Cost

RP pioneer 3D Systems sold 1600 SLA machines from 1988 through 1999. These machines cost $100,000 to 
$800,000. Stereolithography process involves high equipment, material, and maintenance costs. Selective 
Laser Sintering (SLS), the second most popular RP technology have prices range from about $270,000 
to $325,000. Prices range of fused deposition modelling (FDM) is from $100,000 to around $300,000 
[13]. 3D printers are as much as 10 times faster and about one-third as costly – systems cost $75,000 to 
$80,000. A different sort of 3D printer is the Z 402 system from Z Corp., which debuted in 1997 (List 
price: $57,000). System prices of RP technologies are shown in table 1.
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Technology >>
Stereo- 

lithography

Wide  
Area

Inkjet

Selective 
Laser 

Sintering

Fused 
Deposition 
Modelling

Single Jet 
Inkjet

Three 
Dimensional 

Printing

Laminated 
Object 

Manufacturing

Representative 
Vendor >>

3D Systems Stratasys Solidscape Z Corp.
Cubic 
Technologies

General Qualitative Features

Maximum Part 
Size (inches)

20x20x24 10x8x8 15x13x18 24x20x24 12x6x9 20x24x16 32x22x20

Accuracy very good good good fair excellent fair fair

Surface Finish very good fair fair fair excellent fair
fair to poor 

(depending on 
application)

Speed average good
average to 

fair
poor poor excellent good

Strengths

market 
leader, 

large part 
size, 

accuracy, 
wide 

product line

market 
leader, 
office 
okay,

market 
leader, 

accuracy, 
materials,

office 
okay, 
price, 

materials,

accuracy, 
finish, 

office okay,

speed, 
office okay, 

price, 
colour, 
price

large part size, 
good for large 

castings, 
material cost

Weaknesses

post 
processing, 

messy 
liquids

size and 
weight, 
fragile 
parts, 

limited 
mate-
rials, 

part size

size and 
weight, 
system 
price, 

surface 
finish

speed speed, 
limited 

mate-rials, 
part size

limited mate-
rials, 

fragile parts, 
finish

part stability, 
smoke 

finish and 
accuracy

System Price $75–800K $50K $300K $30–300K $70K–80K $30K–70K $120–240K

Material Costs $/pound

Plastics $75–110 $100 $30–60 $115–185 $100 $9

Metal $25–30

Other

$5 
(foundry 

sand)

starch: 
$0.35 / cu in

plaster: 
$0.60 / cu in

+ infiltrant

$5–8 (paper)

Table 5.1: Comparison of important commercial rapid prototyping technologies.

5.5.6 Strengths & Limitations

Stereolithography’s strengths lie in part quality. The process produces a highly accurate model with 
excellent surface finish. These factors make SLA suitable for visual presentations and patterns for tooling.

Download free eBooks at bookboon.com



CAD-CAM & Rapid Prototyping  
Application Evaluation

168 

Reverse Engineering & Rapid Prototyping

SLA has also been limited by its photopolymer materials, which suffered from brittleness and properties 
that can change with humidity and ambient temperature. However, newer SLA materials have evolved 
from acrylic-based to epoxy-based polymers. One of the newest of these is said to emulate PP [15].

An advantage of the SLS process is that it can make parts from thermoplastics-proprietary nylon materials, 
which can be glass-filled. SLS prototypes now approach the aesthetic quality of stereolithography [12]. 
SLS has a significant learning curve, similar to SLA. And fine powder residues on parts require extra 
clean-up effort.

FDM’s strength lies in its simplicity. It extrudes a filament of proprietary ABS material through a heated 
tip. The durable ABS models made with FDM can be sanded, drilled, painted, and tested for fit and 
function [12]. Also, the FDM machine is suitable for an office environment.

The major advantage of Z Corp.’s Z 402 modeller (3DP) is its speed, which outperforms all other RP 
methods. It uses low-cost starch- or plaster-based materials and is relatively affordable. Its limitations 
are in model quality. But the last year has seen improvements in materials, software, and the mechanics 
of deposition that produce higher accuracy and crisper edges [13].
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5.5.7 Materials

Plastics account for the preponderance of materials used in rapid prototyping systems. While in some 
cases, the plastics have the same name and chemical composition as familiar, home-grown materials 
such as nylon or ABS, there are substantial differences in what comes out of an RP system compared to 
the results from machining or injection moulding the same materials [10].

Selective laser sintering (SLS) is the technology which produces plastic parts which most closely emulate 
those from other processes. However, there is always some porosity of at least a few percent because 
the parts are sintered from powder layers, and powders always have spaces between the particles. In a 
similar fashion, fused deposition modelling (FDM) while nominally using materials such as ABS and 
several other thermoplastics, produces parts with a grain structure because they are vectorially extruded 
a layer at a time out of a nozzle [10]. In general, the physical properties of parts produced by a rapid 
prototyping system, such as tensile strength and elongation, will be somewhat poorer than those produced 
by other methods.

Stereolithography and other photopolymer-based methods offer plastic parts, too. However, liquid 
photopolymers are not exactly thermoplastics. The chemistry of photopolymers is very rich, however, 
and these materials are improving at a rapid pace [11]. Photopolymers that imitate polypropylene, 
ABS, polyethylene and a number of other plastics are available, as well as specialty materials for optical, 
medical and other applications.

Inkjet systems also output plastic parts. MultiJet Modeling (MJM) offers a soft, thermoplastic material 
which is essentially a hot melt adhesive. Other inkjets offer polyester or wax-like materials.

It should be noted that while the choice of plastic-like materials is the greatest available in the rapid 
prototyping field, it still is a very limited one – really just a handful compared to the literally thousands 
of materials and grades available for other processes. It’s a very good thing that numerous secondary 
processes exist for changing the output from a rapid prototyping machine into some other material. 
Many of these processes are listed in the tables for tooling applications.

Metals: Commercially available choices are extremely limited for the direct fabrication of metal parts by 
rapid prototyping. For the most part today, metal parts made by rapid prototyping processes are being 
used to make injection moulds. RP technology can offer great time and monetary savings, as well as 
provide functionality, which would be impossible to obtain otherwise [15].
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Selective laser sintering (SLS) offers two basic choices, which can be rudely described as soft and hard. 
The particular materials used are exclusive to each of the two competing SLS brands in the market, EOS 
GmbH (Germany) and 3D Systems. Soft materials comprise either a copper-polyamide system from 3D, 
or a bronze alloy system from EOS. The hard materials are a stainless steel from 3D Systems and steel 
from EOS [15].

Laser engineered net shaping (LENS) and related processes offer the direct fabrication of fully-dense 
steel parts. Final machining is necessary before parts can be used.

Three dimensional printing (3DP) is also being used to make steel parts. DME’s MoldFusion process 
requires similar thermal cycles to selective laser sintering (SLS) to consolidate and infiltrate the parts to 
final density. Finish machining is also required.

Ceramics parts can be acquired from a limited number of commercial sources and a few university labs.

Paper has been the material most closely associated with laminated object manufacturing (LOM). 
Several companies provide systems that fabricate paper parts. One advantage is that the material is very 
inexpensive, but paper parts are not very stable. Paper parts have the look and feel of wood and are often 
used as sand casting patterns [16].

Plaster and starch parts are available from three dimensional printing (3DP) machines made by Z Corp. 
These are also inexpensive material but require some care in handling and must usually be infiltrated 
to make them durable.

Foundry sand parts can be fabricated using selective laser sintering (SLS) and also by a process from 
Generis GmbH (Germany) that is similar to three dimensional printing (3DP). This machine is most 
appropriate for making very large parts [17].

5.6 Conclusions

By building three-dimensional parts in a layer-by-layer additive manner, the RP techniques allow freeform 
fabrication of parts of complex geometry directly from their CAD models automatically, without having 
to use special fixtures as in the material removal processes. The rapid prototyping technology has helped 
product developers to develop their products more rapidly at lower costs in the ever changing and 
more competitive global market. It was initially used to make physical prototypes of three-dimensional 
parts as visualisation and communication aids in design as well as for examining the fit of various 
parts in assembly. It has provided substantial reduction of time-to-market, hence widely called as rapid 
prototyping in industry. Thanks to intensive research and development in the areas of material, process, 
software, and equipment, applications to rapid tooling have also been developed by directly or indirectly 
employing rapid prototyping processes in the tool, die and mould fabrication.
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Rapid Prototyping processes have been used extensively, because they:

•	 Increase effective communication;
•	 Decrease development time;
•	 Decrease costly mistakes;
•	 Minimise sustaining engineering changes;
•	 Extend product lifetime by adding necessary features and eliminating redundant features 

early in the design.

Several business objectives can be significantly improved by using rapid prototyping technologies such 
as marketing new products, manufacturing flexibility; and new product development.

The key to applying the RP technologies for competitive advantage lies in innovative use. This involves 
using the technologies not only to deliver improvements, but also to enable new things, which previously 
might have been impossible or uneconomic.

Whilst the pursuits of time and cost reductions are both clearly necessary business objectives, it is evident 
that by using rapid prototyping in more innovative ways, firms can derive more significant benefits.
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Included in these innovative applications are: the development of new analysis and testing procedures; 
manufacture of production tooling; improving communications across product divisions; and supporting 
customised manufacturing.

Applications of RP technology have found favour in both large and small firms. Time savings on 
prototyping parts vary, ranging from 60 to 80 percent reductions when compared to conventional 
methods for producing prototype components.

Rapid prototyping technologies must be viewed as enablers of new business strategies. Firms should 
therefore be looking at fundamental issues and addressing how they can apply the technologies to support 
expansion into new markets, to increase market share, to differentiate from competitors, to modify the 
basis of competition, and to develop more innovative products.

The main benefits of Rapid Prototyping as a system development tool are the following:

•	 Makes the product real for (at least some) customers and investors; makes them feel that 
real progress is being made;

•	 Enables iteration and change, especially on required design features, early in the design 
process;

•	 Enables detection of errors, leading to better solutions, early in the design process;
•	 Proves that the system is manufacturable, or even feasible;
•	 Although users may find it difficult to describe what they want in a system, they usually 

recognise what they want/don’t want when they see it.

The future looks very promising for rapid prototyping. The benefits for most applications far outweigh 
the disadvantages especially when they are used in the correct situation. The price and size are rapidly 
falling to the point where they will soon be commonplace in any manufacturing company.

There seems to be a divergence in the applications of rapid prototyping. While many companies are 
concentrating on the application to produce physical ‘models’, and hence not fully working components, 
other machines are tending towards the production of fully working components, with research being 
put into vastly improving the mechanical properties of PR components. Other firms are heading in the 
direction of cast and mould making using rapid prototyping processes. The rapid prototyping technology 
is therefore advancing beyond the production of ‘prototype models for which it was originally used.
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